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1 About this document

1.1 Other applicable documents
The information on the safety sensor is distributed over several documents to make working with the docu-
ments easier. You will find the documents and software for the safety sensor in the following table:

1.2 Downloading configuration software from Internet
 Call up the Leuze home page: www.leuze.com.
 Enter the type designation or part number of the device as the search term.
 The configuration software can be found on the product page for the device under the Downloads tab.

1.3 Used symbols and signal words

Table 1.1: Warning symbols and signal words

Purpose and target group of the document Document/software  
title

Source

Software for users of the machinea) for safety sen-
sor diagnostics if a fault occurs and for machine 
design engineersa) for configuring the safety sensor

Sensor Studio
RSL 400 DTM

Supplied with the safety 
sensor on data carrier

Notes for the machine design engineera) “Safe implementation 
and operation”
(this document)

PDF, supplied with the 
safety sensor on data 
carrier

Notes for the machine design engineera) for config-
uring the safety sensor (software instructions)

Online help for soft-
ware

Supplied with the safety 
sensor on data carrier

Notices regarding mounting, alignment and connec-
tion of the safety sensor.

“Quick Start Guide 
RSL 400”

Print document, supplied 
with the safety sensor

a) Machine identifies the product that the safety sensor is installed in.

Symbol indicating dangers to persons

Symbol indicating dangers from harmful laser radiation

NOTICE Signal word for property damage
Indicates dangers that may result in property damage if the measures for dan-
ger avoidance are not followed.

CAUTION Signal word for minor injury
Indicates dangers that may result in minor injury if the measures for danger 
avoidance are not followed.

WARNING Signal word for serious injury
Indicates dangers that may result in severe or fatal injury if the measures for 
danger avoidance are not followed.

DANGER Signal word for life-threatening danger
Indicates dangers with which serious or fatal injury is imminent if the measures 
for danger avoidance are not followed.
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Table 1.2: Other symbols

Table 1.3: Terms and abbreviations

1.4 Checklists
The checklists serve as a reference for the machine manufacturer or supplier (see chapter 11). They 
replace neither testing of the complete machine or system prior to the initial start-up nor their periodic 
testing by a competent person. The checklists contain minimum testing requirements. Depending on the 
application, other tests may be necessary.

Symbol for tips
Text passages with this symbol provide you with further information.


Symbols for action steps
Text passages with this symbol instruct you to perform actions.

CS Switching signal from a control
(Controller Signal)

DTM Software device manager of the safety sensor
(Device Type Manager)

EDM Contactor monitoring
(External Device Monitoring)

FDT Software frame for management of device managers (DTM)
(Field Device Tool)

Field pair A protective field with an associated warning field

DTS Driverless Transportation System

LED LED, display element in the safety sensor
(Light Emitting Diode)

OSSD Safety-related switching output
(Output Signal Switching Device)

PFHd Probability of dangerous Failure per Hour

PL Performance Level

Quad Two field pairs (four fields) that are monitored simultaneously in four field mode

TSS Transverse Side-tracking Skate

RES Start/REStart interlock

SIL Safety Integrity Level

State ON: device intact, OSSDs switched on
OFF: device intact, OSSDs switched off
Locking: device, connection or control/operation faulty, OSSDs switched off 
(lock-out)
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2 Safety
Before using the safety sensor, a risk assessment must be performed according to valid standards (e.g. 
EN ISO 12100, EN ISO 13849-1, IEC 61508, EN IEC 62061). The result of the risk assessment deter-
mines the required safety level of the safety sensor (see table 15.1). For mounting, operating and testing, 
this document as well as all applicable national and international standards, regulations, rules and direc-
tives must be observed. Relevant and supplied documents must be observed, printed out and handed to 
affected persons.
 Before working with the safety sensor, completely read and observe the documents applicable to your 

task.
The following national and international legal regulations in particular apply for start-up, technical tests and 
handling of safety sensors:

• Machinery Directive 2006/42/EC
• Low Voltage Directive 2006/95/EC
• EMC Directive 2004/108/EC
• Use of Work Equipment Directive 89/655/EEC supplemented by Directive 95/63 EC
• OSHA 1910 Subpart O
• Safety regulations
• Accident-prevention regulations and safety rules
• Betriebssicherheitsverordnung (Ordinance on Industrial Safety and Health) and employment protec-

tion act
• Product Safety Law (ProdSG)

2.1 Approved purpose
The safety sensor protects persons or body parts at points of operation, danger zones or access points of 
machines and systems.

• The safety sensor may only be used after it has been selected in accordance with the respectively 
applicable instructions and relevant standards, rules and regulations regarding labor protection and 
safety at work, and after it has been installed on the machine, connected, commissioned, and 
checked by a competent person (see chapter 2.4).

• When selecting the safety sensor it must be ensured that its safety-related capability meets or 
exceeds the required performance level PLr ascertained in the risk assessment (see table 15.1).

• With the “access guarding” function, the safety sensor detects persons only when they enter the dan-
ger zone but cannot tell whether there are any persons inside the danger zone. For this reason, a 
start/restart interlock in the safety chain is essential in this case.

• The construction of the safety sensor must not be altered. When manipulating the safety sensor, the 
protective function is no longer guaranteed. Manipulating the safety sensor also voids all warranty 
claims against the manufacturer of the safety sensor.

• The safety sensor must be inspected regularly by a competent person to ensure proper integration 
and mounting (see chapter 2.4).

• The safety sensor must be exchanged after a maximum of 20 years. Repairs or exchange of wear 
parts do not lengthen the mission time.

For safety-related information you may also contact the local authorities (e.g., industrial inspec-            
torate, employer's liability insurance association, labor inspectorate, occupational safety and         
health authority).

WARNING
A running machine may result in serious injury!
Make certain that the safety sensor is correctly connected and that the protective function of the pro-

tective device is ensured.
Make certain that, during all conversions, maintenance work and inspections, the system is securely 

shut down and protected against being restarted.
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2.1.1 Vapors, smoke, dust, particles
Vapors, smoke, dust and all particles visible in the air can cause the machine to switch off unintentionally. 
This can mislead the user into bypassing the safety devices.
 Do not use the safety sensor in environments in which heavy vapors, smoke, dust or other visible par-

ticles occur at the beam level.

2.1.2 Stray light

Light sources can impair the safety sensor's availability. Interfering light sources are:
• Infrared light 
• Fluorescent light 
• Strobe light 

 Ensure that there are no interfering light sources at beam level.
 Prevent reflective surfaces at beam level.
Where applicable, take protective field addition distances into account.
 Implement all additional measures to ensure that any special application of any effected beam types 

does not impair the safety sensor's operation.

2.1.3 Obstructions in the protective field
 Do not bring any additional window materials into the area monitored by the safety sensor.

2.2 Foreseeable misuse
Any use other than that defined under “Intended use” or which goes beyond that use is considered 
improper use.

In principle, the safety sensor is not suitable as a protective device for use in the following cases:
• Danger posed by ejected objects or the spraying of hot or hazardous liquids from within the danger 

zone.
• Applications in explosive or easily flammable atmospheres.
• Use for outdoor applications or under extreme temperature fluctuations.

Humidity, condensation and other weather influences can impair the protective function.
• Use on vehicles with combustion engines. 

Alternators and ignition systems can cause EMC interferences.

CAUTION
Observe intended use!
 Only operate the device in accordance with its intended use.

The protection of personnel and the device cannot be guaranteed if the device is operated in a manner 
not complying with its intended use.
Leuze electronic GmbH + Co. KG is not liable for damages caused by improper use.

 Read these original operating instructions before commissioning the device.
Knowledge of the original operating instructions is an element of proper use. 

NOTICE
Comply with conditions and regulations!
 Observe the locally applicable legal regulations and the rules of the employer's liability insurance asso-

ciation.
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2.3 Responsibility for safety
Manufacturer and operating company must ensure that the machine and implemented safety sensor func-
tion properly and that all affected persons are adequately informed and trained.
The type and content of all imparted information must not lead to unsafe actions by users.

The manufacturer of the machine is responsible for:
• Safe machine construction
• Safe implementation of the safety sensor, verified by the initial test performed by a competent person
• Imparting all relevant information to the operator
• Adhering to all regulations and directives for the safe commissioning of the machine

The operator of the machine is responsible for:
• Instructing the operator
• Maintaining the safe operation of the machine
• Adhering to all regulations and directives on industrial safety and safety at work
• Regular testing by competent persons

2.4 Competent persons
Connecting, mounting, commissioning and adjustment of the safety sensor must only be carried out by 
competent persons.

Prerequisites for competent persons:
• They have a suitable technical education.
• They know the rules and regulations for labor protection, safety at work and safety technology and 

can assess the safety of the machine.
• They know the operating instructions for the safety sensor and the machine.
• They have been instructed by the responsible person on the mounting and operation of the machine 

and of the safety sensor.
• They perform a task related to the subject matter shortly thereafter and keep their knowledge up to 

date through continuous further training.

Certified electricians
Electrical work must be carried out by a certified electrician.
Due to their technical training, knowledge and experience as well as their familiarity with relevant stan-
dards and regulations, certified electricians are able to perform work on electrical systems and indepen-
dently detect possible dangers.
In Germany, certified electricians must fulfill the requirements of accident-prevention regulations BGV A3 
(e.g. electrician foreman). In other countries, there are respective regulations that must be observed.

NOTICE
Do not modify or otherwise interfere with the device!
 Do not carry out modifications or otherwise interfere with the safety sensor.

The safety sensor must not be tampered with and must not be changed in any way.
The safety sensor must not be opened. There are no user-serviceable parts inside.
The construction of the safety sensor must not be altered. When manipulating the safety sensor, the 
protective function is no longer guaranteed. Manipulating the safety sensor also voids all warranty 
claims against the manufacturer of the safety sensor.
Repairs must only be performed by Leuze electronic GmbH + Co. KG.
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2.5 Exemption of liability
Leuze electronic GmbH + Co. KG is not liable in the following cases:

• The safety sensor is not used as intended.
• Safety notices are not adhered to.
• Reasonably foreseeable misuse is not taken into account.
• Mounting and electrical connection are not properly performed.
• Proper function is not tested (see chapter 11).
• Changes (e.g., constructional) are made to the safety sensor.

2.6 Laser safety notices – Laser class 1 for wavelength range outside 400 - 700 nm

ATTENTION, INVISIBLE LASER RADIATION – LASER CLASS 1
The device fulfills the IEC 60825-1:2007 (EN 60825-1:2007) requirements for a product in laser class 1 
as well as the U.S. 21 CFR 1040.10 regulations with deviations corresponding to “Laser Notice No. 50” 
from June 24th, 2007.
 Observe the applicable statutory and local laser protection regulations.
 The device must not be tampered with and must not be changed in any way.

There are no user-serviceable parts inside the device.
Repairs must only be performed by Leuze electronic GmbH + Co. KG. 

Additional measures for shielding the laser radiation are not necessary (safe for eyes).
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3 Device description 
The safety sensors from the RSL 400 series are optoelectronic, two-dimensional measuring safety laser 
scanners. They satisfy the following standards:

1 Scanner unit 
2 Connection unit
3 Optics cover
4 Alphanumerical display (displayed)
5 LED indicators

Figure 3.1: Device overview of safety laser scanner RSL 400

RSL 400

Type in accordance with IEC/EN 61496 3

Category in accordance with EN ISO 13849 3

Safety Integrity Level (SIL) in accordance with IEC 61508 2

SILCL in accordance with IEC/EN 62061 2

Performance Level (PL) in accordance with EN ISO 13849-1 d

1

2

4

5

3
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All safety sensors of the RSL 440 series are equipped as follows:

• Laser scanner with the range class S, M, L or XL:

• 24-digit alphanumerical display
• Integrated electronic spirit level for aligning the safety sensor
• LED indicators

• Connection unit:

• Configuration memory
• Ethernet connection for communication and configuration with the PC/laptop
• Electrical connection to the machine via connection cable

3.1 Device overview
The following table provides an overview of the possible uses, features and functions of the RSL 400 
safety sensors.

Table 3.1: Device overview

3.1.1 Protective function of RSL 400 safety sensors
The safety sensor transmits periodic light pulses via a rotating deflection unit. The light pulses are scat-
tered in all directions by obstacles, e.g. persons. A part of the light pulses is received again by the safety 
sensor and evaluated. The safety sensor calculates the precise position of the object from the propagation 
time of the radiated light and the current angle of the deflection unit at that time. If the object is within a 
predefined area, the protective field, the safety sensor performs a safety-related switching function. It 
switches the safety-related switching outputs off.

Range class Operating range [m]

S 3.00

M 4.5

L 6.25

XL 8.25

RSL 410 RSL 420 RSL 430 RSL 440

Stationary danger zone guarding x x x x

Mobile danger zone guarding x x x x

Access guarding x x x x

Point of operation guarding x x x x

Safety-related switching outputs
Protective function A
Protective function B

1 OSSD pair
x
-

1 OSSD pair
x
-

2 OSSD pairs
x
x

2 OSSD pairs
x
x

Signal outputs Up to 3 Up to 4 Up to 9 Up to 9

Configurable signal outputs x x x x

Number of changeover-capable 
protective/warning field pairs

1 10 10 + 10 100

E-Stop linkage - x x x

Four field mode (quads) x x x x

Internal safe time delay - - x x
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Only when the protective field is free again does the safety sensor reset the safety-related switching func-
tion, either automatically or following acknowledgment, depending on the operating mode. 
The safety sensor can even detect people when they are wearing very dark clothes, which have a very 
weak diffuse reflectance. 

3.1.2 Parameters for protective function

The following parameters for switching off the safety-related switching outputs of the safety sensor are 
taken into consideration for the protective function:

• Configurable protective fields
• Reference contour of protective fields
• Configurable field pair changeover
• Selectable resolution for hand, leg or body detection
• Safety sensor response time
• Selectable start-up behavior

The following non-safety-oriented functions and signals also belong to the protective function:
• Configurable warning fields
• Configurable indication signals

Additional functions of the protective function
• Warning field evaluation
• Selectable dynamic contactor monitoring (EDM)
• E-Stop 

Two protective functions function mode
• The safety sensor can be configured for two independent protective functions. 
• If the safety sensor is configured for one protective function, an internal safe time delay can be 

selected for switch-off of the second OSSD pair.

3.1.3 Device and monitoring functions

• Monitoring and release of field pair changeover
• Configurable output of the indication signals for the following functions groups:

• Protective function
• Warning messages
• Error messages
• Diagnosis
• Status messages

3.2 Connection unit
The safety sensor is mounted, connected and aligned using the connection unit.
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1 Connection cable, connection to the machine
2 M12 socket, D-coded, Ethernet communication connection
M5 Connection for functional earth with M5 x 10 self-cutting/self-tapping (gas tightness) and ground 

strap
Figure 3.2: Device overview, connection unit

Functions of connection unit:
• Attachment point for mounting, either directly or using an optional mounting system

When devices are swapped out, the connection unit remains mounted and aligned.
• EMC wiring for signal inputs/outputs and supply using connection cable

• Connector bushing and EMC for the Ethernet TCP/IP communication and configuration interface to 
the PC/laptop

• Memory for the configuration files and automatic parameter transfer in the event of device swap-out
• Quick-release connection to the scanner unit (see Quick Start Guide) for easy device swap-out

3.3 Display elements
The display elements of the safety sensors simplify start-up and fault analysis.

3.3.1 LED indicators
Located on the connection unit are six LEDs for displaying the operating state.

• Protective function A: LEDs 1, 2, 3
• Protective function B: LEDs 4, 5, 6

M5  2x

2 1

Safety sensor Connection unit Connection

RSL 440 CU429-y
y=5000, 10000, 
25000

Connection cable, 29-wire
5 m, 10 m, 25 m
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1 LED 1, red/green, protective function A
2 LED 2, yellow, protective function A
3 LED 3, blue, protective function A
4 LED 4, blue, protective function B
5 LED 5, yellow, protective function B
6 LED 6, red/green, protective function B

Figure 3.3: LED indicators

Table 3.2: Meaning of the LEDs

1 2 3 4 5 6

LED Color State Description

1.6 Red/green OFF Device switched off

Red OSSD off

Red, flashing Error

Green OSSD on

2.5 Yellow OFF RES deactivated
RES activated and enabled

Blinking Protective field occupied

ON RES activated and blocked but ready to be 
unlocked
Protective field free and linked sensor enabled (if 
applicable)

3.4 Blue OFF No internal function call active (e.g. warning field 
free)

ON Internal function call (e.g. warning field occupied)
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3.3.2 Alphanumerical display
In normal operation, the 24-digit alphanumerical display of the safety sensor shows the monitored protec-
tive and warning field pairs. It also provides assistance during detailed fault diagnosis (see chapter 12). 

Table 3.3: Alphanumerical displays 

Display Description Example

Upon startup without configuration/upon initial commissioning

Sensor type Sensor type 420M

Sensor serial number Serial number of the sensor SN: 21513123456

Sensor name / Network 
name

Name of the sensor / network A123456789

Configuration necessary Configuration required CONFIG REQUESTED

Repeated until end of booting phase / start phase, then

Spirit level permanent Horizontal alignment in degrees: H
Vertical alignment in degrees: V

H -3° V +9°

Upon startup with configuration

Sensor type Sensor type 410XL

Sensor serial number Serial number of the sensor SN: 21513123456

Sensor name / Network 
name

Name of the sensor / network A123456789

IP: DHCP/FIX DHCP or permanent IP address IP: DHCP or
10.25.45.2

Bluetooth on/off Bluetooth detection ON/OFF Bluetooth ON

Date of configuration Date of configuration 11/13/2014 08:15

Signature Signature of configuration DG45L8ZU

Spirit level Horizontal alignment in degrees: H
Vertical alignment in degrees: V

H-3° V+9°

Repeated until end of booting phase / start phase, then

Display following configuration of normal operation
e.g. display of active field pair A1.1

Transfer of the configuration data

AWAITING CONFIG Until downloading of configuration data is confirmed

DOWNLOAD CONFIG During transfer of configuration data

Spirit level

H +/- ..° V +/- .. ° Horizontal alignment in degrees: H
Vertical alignment in degrees: V

H -3° V +9°

Sensor detection

PING received Display for identification by device name PING received Device 
name

Message
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For error diagnostics, the error's respective letter is displayed first followed by the number code. An 
AutoReset is carried out after 10 seconds for errors that do not cause locking, with an unauthorized restart 
being impossible. In the case of blocking errors, the voltage supply must be separated and the cause of 
the error must be eliminated. Before switching on again, the steps taken before initial commissioning must 
be repeated (see chapter 10).
When the protective field has been free for about 5 seconds, the device switches back to the display in 
normal operation.

Displays in normal operation
The display in normal operation depends on the operating state of the safety sensor. The display can be 
switched off or rotated by 180° by means of the software.

3.3.3 Field-of-view display
The upper and lower limit of the safety sensor's field of view can be displayed by means of horizontal lines 
on the optics cover.
Make sure that the safety sensor's field of view is always completely unobstructed.

3.4 Mounting system (optional)
Mounting systems and mounting brackets simplify mounting and alignment of the safety sensor. Mounting 
systems and mounting brackets are available as accessories (see table 17.3).

3.5 Loop guard (optional)
The loop guard for the optics cover prevents damage to the safety sensor caused by light contact with 
foreign objects. The loop guard is available as an accessory (see table 17.3).

Message via a signal output or diagnosis ID ProtF A: E123
Device: P007 - wrong 
Config

Fault diagnosis

F… Failure, internal device error

E… Error, external error

U… Usage info, application error

I… Information

P… Parameter, inconsistency in the configuration

Display Description Example

NOTICE
Always check the protective field configuration!
 Check all defined protective fields each time the configuration is changed.

The field-of-view display is a comfort function and is not intended as a substitute for checking the pro-
tective field configuration.

 The safety sensor's field of view must be completely unobstructed on the application side.
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4 Configuration and diagnostic software Sensor Studio
To start up a safety sensor in your application, the safety sensor must be set up according to its specific 
use using the configuration and diagnostic software. The software is used to set up the safety configuration 
of the safety sensor, to change the communication and diagnostics settings and to perform diagnostic 
routines. Communication takes place via the PC.
The software is designed according to the FDT/DTM concept:

• You make the individual configurations for the safety sensor in the Device Type Manager (DTM).
• The individual DTM configurations of a project can be called up via the frame application of the Field 

Device Tool (FDT).
• Each device DTM has a communication DTM that sets up and monitors the communication connec-

tions to the sensor.

4.1 System requirements
To use the software, you need a PC or laptop with the following specifications:

4.2 Installing software

Prerequisites:
• You do not need the safety sensor to install the software on the PC.
• All Windows applications are closed. 

Installing the Sensor Studio software

Only use the software for safety sensors manufactured by Leuze electronic.

Hard disk space At least 250 MB free memory
If you want to save the protective field or configuration values, you 
will need more memory.

Screen display Color
External drive DVD drive
Input device Keyboard and mouse or touchpad
Output device Printer (black-white or color)
Interfaces RJ45 Ethernet network

Bluetooth (optional) - If the PC does not have integrated Bluetooth 
technology, use an appropriate USB or PCMCIA adapter if neces-
sary.

Operating system Microsoft® Windows 7 and Windows 8.1

Only the term “PC” is used below.

The software is installed in two steps:

- Install the Sensor Studio FDT frame. 

- Install the LeSafetyCollection device manager (DTM).

If FDT frame software is already installed on your PC, you do not need the Sensor Studio instal-                 
lation. 

You can install the device manager (DTM) in the existing FDT frame.
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 Insert the data carrier. 
The installation will start automatically. 
 If installation does not start automatically, double-click the file SensorStudioSetup.exe.
 If you want to call up the menu of the CD, double-click the file start.exe.
 Select a language for the interface text in the installation wizard and software and confirm with [OK].
The installation wizard starts.
 Click [Next]. 
The installation wizard opens the software license agreement.
 If you want to accept the license agreement, select the appropriate option field and click [Next]. 
 If the suggested installation path is OK, click [Next].

If you want to specify a different path, click the [Browse] button. Select a different path, confirm with [OK] 
and click [Next]. 

 Click the [Install] button to start installation
The wizard installs the software and places a shortcut on the desktop ( ).
 Click the [Finish] button to complete installation.

Installing LeSafetyCollection device manager (DTM)

Prerequisites:
• The Sensor Studio software is installed on the PC.
• Data carrier inserted.

 Double-click the file LeSafetyCollectionSetup.exe.
 Select a language for the interface text in the installation wizard and software and confirm with [OK].
The installation wizard starts.
 Click [Next]. 
The installation wizard opens the software license agreement.
 If you want to accept the license agreement, select the appropriate option field and click [Next]. 
 If the suggested installation path is OK, click [Next].

If you want to specify a different path, click the [Browse] button. Select a different path, confirm with [OK] 
and click [Next]. 

 Click the [Install] button to start installation.
The wizard installs the software.
 Click the [Finish] button to complete installation.

During installation of the software, a user admin (without password query) is created so that you               
can start the software without user identification. If other users are registered (Tools > User man-               
agement in the FDT frame menu), you must log in at the software with a user name and pass-                  
word.

This setting allows you to connect to the safety sensor and to read out, upload, enter or change                 
the safety configuration and all settings using the RSL 400 device DTM. The password for the               
safety sensor only needs to be entered (i.e. the access level only needs to be changed) when                
the changes are downloaded to the safety sensor (see chapter 4.5.1).
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4.3 User interface

1 FDT frame menu with toolbar
2 RSL 400 device manager (DTM)
3 Navigation tabs
4 Information area
5 Dialog box
6 Status bar
7 Navigation area

Figure 4.1: User interface of the software

FDT frame menu
The device managers (DTM) of the safety sensors are created and managed in the FDT frame menu.

Device manager DTM
Configuration projects for setting up the selected safety sensor are created and managed in the device 
managers (DTM) of the safety sensors.

2 3

4

5

1

6

7
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Project tree view

1 FDT frame menu
2 Device manager (DTM) tabs
3 Project tree view

Figure 4.2: User interface with project tree view

The project tree view shows the structure of the currently installed device managers (DTM). In the project 
tree view you can, for example, add copies of an already configured device manager (DTM) quickly and 
easily to the DTM structure if you want to operate multiple safety sensors with the same configuration 
settings.
Example: DTS with safety sensors on front and rear side

4.4 FDT frame menu

4.4.1 Project Wizard
Using the Project Wizard you can create and change configuration projects for setting up the safety sensor 
(see chapter 4.5 "Using configuration projects"). 
 Start the Project Wizard in the FDT frame menu by clicking the  button.

4.4.2 DTM Change
The DTM Change function makes it easier for you to call up the communication DTM of a device or change 
from device DTM to communication DTM. 
 Start the DTM change function in the FDT frame menu by clicking the  button.

21

3

You can find complete information on the FDT frame menu in the online help system. Select the                
Help menu item in the menu [?].

Information on the Project Wizard can be found in the online help for the FDT frame menu under                 
Sensor Studio Options.

Information on DTM change can be found in the online help for the FDT frame menu under  
Sensor Studio Options.
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4.4.3 User management
Using the user management in the FDT frame menu, you can create users, log users in/out and manage 
passwords. 

Creating users
When creating a user in the user management via Tools > User management in the software frame menu, 
select the access level for the user. For information on access permissions and access levels (see 
chapter 5.1 "Authorization concept of safety sensor").
 In the FDT frame menu, click Tools > User management > Create user.

Logging users in/out
Prerequisites:

• Users have been created
 In the FDT frame menu, click Tools > Log in/log out.

Managing passwords
Prerequisites:

• Users have been created
 In the FDT frame menu, click Tools > Change password.

4.4.4 Exiting Sensor Studio 
When you have finished making the configuration settings, close the configuration and diagnostics soft-
ware.
 Exit the program via File > Exit.
 Save the configuration settings as a configuration project on the PC.
You can open the configuration project again at later time via File > Open or with the Sensor Studio Project 
Wizard (  ).

4.5 Using configuration projects
Configuration projects are created and managed in the device manager (DTM) of the selected safety 
sensor.

 Start the configuration and diagnostics software on the PC by double-clicking the  button.

• The mode selection of the Project Wizard is displayed.
• If the mode selection is not shown, start the Project Wizard in the FDT frame menu by clicking the 

[Project Wizard] button ( ).

Password management via the FDT frame menu applies to all installed device managers (DTM)             
of the project. 

Whenever write access occurs, the safety sensors of the RSL 400 series always check the              
access level (Engineer, Expert) and the password defined via the device manager (DTM)  
(SETTINGS > Passwords) independently of the password management via the FDT frame           
menu.

During installation of the software, a user admin (without password query) is created so that you               
can start the software without user identification. If other users are registered (Tools > User man-               
agement in the FDT frame menu), you must log in at the software with a user name and pass-                  
word.

This setting allows you to connect to the sensor and to read out, upload, enter or change the                 
safety configuration and all settings using the RSL 400 device DTM. The password for the sensor               
only needs to be entered (i.e. the access level only needs to be changed) when the changes are                 
downloaded to the safety sensor (see chapter 4.5.1).
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Figure 4.3: Project Wizard

 Select the configuration mode and click [Next].

• Automatic connection to a connected safety sensor (Online)
• Device selection without communication connection (Offline)
• Load a saved project again

The project wizard displays the SEARCH DEVICES dialog box.
 Select the interface and click the [Start] button.
 Find the safety sensor for your configuration project using the search function of the communication 

DTM.

1 FDT frame menu
2 Communication DTM 
3 Device list
4 Search function

Figure 4.4: Communication DTM with search function

21
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The project wizard displays the device list of configurable safety sensors in the SEARCH DEVICES dialog 
box.

Figure 4.5: Device selection in project wizard

 Select the safety sensor from the device selection list and click [Next].
The device manager (DTM) of the safety sensor shows the initial screen for the configuration project. 

Figure 4.6: Initial screen for safety configuration

The device manager (DTM) starts without querying the access level of the user. During commu-              
nication with the safety sensor, the safety sensor does however query the access level of the               
user. To change the access levels (see chapter 4.5.1 "Selecting access level"). 
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Setting device manager
Using the menus of the device manager (DTM) you can set the parameters of the safety configuration. The 
online help system provides information on the menu items and adjustment parameters. Select the Help 
menu item in the menu [?].

4.5.1 Selecting access level
Using the device manager you can change the access level of the user if necessary.
For the authorization concept of the software, see chapter 5.1 "Authorization concept of safety sensor".
 Click in the DTM menu bar on the [Change access level] button ( ).
The Change access level dialog box opens.
 In the Access level list, select the item Expert, Engineer or Observer and enter the default password or 

the password defined for the individual user. 

The following access levels are available:
• Observer can read everything (no password)
• Expert can change communication and diagnostics settings (default password = comdiag)
• Engineer can additionally change the safety configuration (default password = safety)

The password is case-sensitive (i.e. a distinction is made between upper-case and lower-case letters).
 Confirm with [OK].

4.5.2 IDENTIFICATION
Detailed information on the menu items and setting parameters can be found in the information area and 
in the online help. Select the Help menu item in the menu [?].

• Safety laser scanner RSL 400
• Sensor and configuration data
• Technical data

4.5.3 PROCESS
Detailed information on the menu items and setting parameters can be found in the information area and 
in the online help. Select the Help menu item in the menu [?].

• Sensor display
Device display in the DTM menu

• SENSOR DISPLAY
• STATE OF THE ACTIVE PROTECTIVE AND WARNING FIELDS
• SENSOR DATA

• Measurement contour
• Inputs / outputs

• SENSOR DISPLAY
• CONNECTIONS AND SIGNALS

• Simulation – only with access level Engineer 
• Measurement contour
• Inputs / outputs

4.5.4 CONFIGURATION
see chapter 9 "Configuring the safety sensor"

You can only transfer changes made in the CONFIGURATION menu to the safety sensor if you               
are logged in with the access level Engineer. 
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4.5.5 DIAGNOSIS
Adjustment / Alignment
Display of safety sensor alignment using the integrated electronic spirit level
Prerequisites: The software and safety sensor are connected.
 In the DIAGNOSIS menu, click the [Align sensor mechanically] button ( ).
The safety sensor display shows the horizontal and vertical alignment in degrees.
Visually identify device
If you have installed multiple safety sensors, identify the safety sensor that is connected to the currently 
open device manager (DTM).
Prerequisites: The software and safety sensor are connected.
 In the DIAGNOSIS menu, click the [Visually identify sensor] button ( ).
In the display of the safety sensor connected to the device manager (DTM), the message “PING received” 
flashes for ten seconds.

Reset sensor
Acknowledge messages and faults
Set safety sensor to safety mode

Create and save service file
The service file contains all available information on the safety sensor as well as configuration and 
settings.
When requesting support, send the service file to the Leuze electronic customer service (see chapter 14 
"Service and support").
Sensor display
Device display in the DTM menu

• SENSOR DISPLAY
• STATE OF THE ACTIVE PROTECTIVE AND WARNING FIELDS
• SENSOR DATA

Diagnostics list
Access list
EventLog

4.5.6 SETTINGS

Communication

• LAN

• DHCP
• CONNECTION SETTINGS
• MAC address

• Bluetooth

• Activate Bluetooth module
• Activate device scan
• Bluetooth address

Data telegrams
A UDP telegram can be configured which sends the status profile of the safety sensor as well as the 
measurement data to a receiving device connected via Ethernet, e.g. to a PC.

EventLog
Trigger signals output when certain events occur, are recorded and shown in the event list of the safety 
sensor.

You can only transfer changes made in the SETTINGS menu to the safety sensor if you are                
logged in with the access level Engineer. 
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Information on the monitored signals can be found in the information area and in the online help. Select 
the Help menu item in the menu [?].

Sensor display
Activation of the safety sensor alphanumerical display.
Information on the display options can be found in the information area and in the online help. Select the 
Help menu item in the menu [?].

Passwords

CHANGE PASSWORD
 Define individual passwords for the access levels Engineer and Expert. These passwords replace the 

default passwords set by the manufacturer.
The password is case-sensitive (i.e. a distinction is made between upper-case and lower-case letters).

One-time password

Prerequisites:
• The software is connected to the safety sensor.

 Generate a one-time password.
Note down the generated one-time password.

 Send the one-time password to the Leuze electronic customer service for confirmation (see chapter 14 
"Service and support").
The device can now be switched off and the connection can be terminated.

 Enter the confirmed password and create a new password.

Optics cover

• Monitoring of optics cover
• Dialog box for calibrating a replacement optics cover

Field editor display options

Display settings for the field editor when defining protective/warning fields.
• CONTOUR ALIGNMENT
• COORDINATE DISPLAY
• EDITOR BEHAVIOR

Information on the display options can be found in the information area and in the online help. Select the 
Help menu item in the menu [?].

If a user has forgotten his password for login at the safety sensor or has repeatedly entered the                 
password incorrectly, he cannot log in at the safety sensor. The CHANGE PASSWORD function             
is therefore not available.

To reset the password, a user must generate a one-time password and have it confirmed by the                
manufacturer.
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5 Functions
The functions of the safety sensor must be matched to the respective application and its safety require-
ments. You can activate/deactivate the functions and adapt them using parameters. You configure the 
functions with the help of the configuration and diagnostics software (see chapter 9 "Configuring the safety 
sensor").

• You configure the functions of the safety sensor in the software as configuration projects.
• In each configuration project you determine the protective function and the configurable field pairs 

via the selected function mode.
• The changeover-capable protective/warning field pairs for the selected function mode are defined in 

configuration banks.
• You determine the resolution, the start-up behavior, the response time and, where applicable, the 

vehicle speed together for all protective/warning field pairs of a configuration bank.

5.1 Authorization concept of safety sensor
User management allows target-group-oriented communication between the software and the safety 
sensor. Which functions are available depends on the selected access level of the user. For information 
on the software and on user management (see chapter 4 "Configuration and diagnostic software 
Sensor Studio").

• Changing the safety configuration as well as the communication and diagnostics settings of the sen-
sor is only permitted for certain access levels.

• Installation and operation of the software do not depend on the access level of the user.
The following access levels are available: 
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Table 5.1: Access levels and functions available

Determining access level
When creating a user in the user management via Tools > User management in the FDT frame menu, 
select the access level for the user. In the user management you can also create and change passwords 
for the users. 
Using the device manager (DTM) you can change the access level of the user (see chapter 4.5.1 
"Selecting access level"). 

• Click in the DTM menu bar on the [Change access level] button ( ).

5.2 Function modes of safety sensor
You configure the functions of the safety sensor in configuration projects with the help of the configuration 
and diagnostics software. In each configuration project you determine the protective function and the 
configurable field pairs via the selected function mode.
You select the function mode of the safety sensor in the software device manager (DTM) with  
CONFIGURATION > OSSDs (see chapter 9 "Configuring the safety sensor").
You use the protective function to define the criteria for switching off the safety-related switching outputs 
(see chapter 3.1.2 "Parameters for protective function").
The changeover-capable protective and warning field pairs for the selected function mode are defined in 
the configuration banks, e.g. CONFIGURATION > Protective function A > Bank A1.

Access level Functions

Observer • Display the measurement contour
• Upload and display configuration data from the safety sensor
• Display status information from the safety sensor
• Display diagnostics list
• Customize display
• Display and evaluate the measurement contour
• Load configuration data from the safety sensor
• Load status information from the safety sensor
• Display diagnostics list
• Create service file
• Reset password

Expert In addition to the functions of the Observer
• Load the signed safety configuration from a file and transfer/download 

to the safety sensor
• Transfer changed communication and diagnostics settings from the 

PC to the safety sensor
• Print configuration data incl. protective/warning fields
• Calibrate optics cover

Engineer In addition to the functions of the Expert, full access to all user-relevant 
functions and parameters: 
Create and change a safety configuration:

• Save configuration data to file
• Change all parameters of configuration
• Reset safety sensor to default values 
• Define and change protective/warning fields
• Set reference contour in protective field
• Print and delete protective/warning fields
• Load protective/warning field data from file
• Save protective/warning field data
• Transfer protective/warning field data from the PC to the safety sensor
• Change passwords

The software saves individual passwords in the connected safety sensor, thereby ensuring that            
only authorized users can change the existing configuration.
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Overview of the function modes

Table 5.2: Function modes

Function mode Field pairs (FP)
Protective field (PF)
Warning field (WF)

Field pair activation

One protective function 1 FP / 1 PF + 1 WF Fixed selection of a field pair

5 FP / 5 PF + 5 WF) Selection by signal input:
• Overlapped monitoring

10 FP / 10 PF + 10 WF) Selection by signal input:
• Fixed changeover moment

One protective function - 100 FP 1 FP / 1 PF + 1 WF Fixed selection of a field pair

100 FP / 100 PF + 100 WF Selection by signal input:
• Fixed changeover moment

Two protective functions Protective function A:1 FP / 1 PF 
+ 1 WF
Protective function B:1 FP / 1 PF 
+ 1 WF

Fixed selection of a field pair

Protective function A:5 FP / 5 PF 
+ 5 WF)
Protective function B:5 FP / 5 PF 
+ 5 WF)

Selection by signal input:
• Overlapped monitoring

Protective function A:10 FP / 
10 PF + 10 WF)
Protective function B:10 FP / 
10 PF + 10 WF)

Selection by signal input:
• Fixed changeover moment

One protective function - four field 
mode

1 FP / 1 PF + 3 WF Fixed selection of a field pair

10 FP+ 10 FP / 10 PF + 30 WF Selection by signal input:
• Fixed changeover moment

Two protective functions - four 
field mode

Protective function A:1 FP / 1 PF 
+ 1 WF
Protective function B:1 FP / 1 PF 
+ 1 WF

Fixed selection of a field pair

Protective function A:50 FP / 
50 PF + 50 WF
Protective function B:50 FP / 
50 PF + 50 WF

Selection by signal input:
• Fixed changeover moment

One protective function - multi 
configuration

1 FP / 1 PF + 1 WF Fixed selection of a field pair

10 x 10 FP /
10 x (10 PF + 10 WF)

Selection by signal input:
• Fixed changeover moment

Two protective functions - multi 
configuration

2 x 1 x 1 FP
2 x 1 bank x (1 PF + 1 WF)

Fixed selection of a field pair

2 x 5 x 10 FP
2 x 5 banks x (10 PF + 10 WF)

Selection by signal input:
• Fixed changeover moment
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5.2.1 One protective function
Ten changeover-capable field pairs for safety-related switching outputs OSSD-A. For the field pair change-
over, see chapter 5.7 "Field pair changeover".
Safe, time-delayed switch-off of safety-related switching outputs OSSD-B.

5.2.2 One protective function – 100 field pairs
A configuration bank with 100 changeover-capable field pairs for safety-related switching outputs  
OSSD-A. For the field pair changeover, see chapter 5.7.4 "Changeover of 100 field pairs".
Safe, time-delayed switch-off of safety-related switching outputs OSSD-B.

Example of use: 
• DTS with varying operating conditions and different speed levels

5.2.3 Two protective functions
In this function mode, you configure independent protective functions with all associated safety parame-
ters for safety-related switching outputs OSSD-A and OSSD-B. 

• For each protective function you can define up to ten field pairs in one configuration bank. 
• Field pair actuation and field pair changeover take place separately and independently for each con-

figuration bank. 
For the field pair changeover, see chapter 5.7 "Field pair changeover".

5.2.4 One protective function - four field mode
The safety sensor monitors one protection field and three warning fields.
Monitoring is performed together for the field pairs of protective function A and protective function B. If, for 
example, the control system is monitoring field pair A1.1 for protective function A, field pair B1.1 for protec-
tive function B is also monitored.

1 Protective function A: protective field
2 Protective function B: protective field
3 Protective function A: warning field
4 Protective function B: warning field

Figure 5.1: Four field mode

If the protective field of protective function A is violated, safety-related switching outputs OSSD-A switch.
If the protective field of protective function B is violated, the indication signal B-CLEAR is generated – the 
safety-related switching outputs do not switch.
The signals are assigned to the switching outputs via the configuration and diagnostics software  
(CONFIGURATION > Outputs; see chapter 9 "Configuring the safety sensor").

A1.1P

B1.1P

A1.1W

B1.1W

1

2

3

4
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Table 5.3: Example: Assignment of signals to switching outputs

5.2.5 Two protective functions - four field mode
In this function mode, you configure the protective functions for safety-related switching outputs OSSD-A 
and OSSD-B. 

• The safety sensor monitors two protective fields and two warning fields.
• Controlled switch-off via safety-related switching outputs OSSD-A and OSSD-B.

• If the protective field of protective function A is violated, safety-related switching outputs OSSD-A 
switch.

• If the protective field of protective function B is violated, safety-related switching outputs OSSD-B 
switch.

• Field pair actuation and field pair changeover take place together for the field pairs of protective func-
tion A and protective function B. 
If, for example, the control system actuates the field pair A4.2 for protective function A, the field pair 
B4.2 for protective function B is also actuated.

1 Protective function A: protective field
2 Protective function B: protective field
3 Protective function A: warning field
4 Protective function B: warning field

Figure 5.2: Four field mode

Logic signal Electrical switching output Description

OSSD A Safety-related switching outputs 
OSSD A

Protective function A: Violation of protec-
tive field

B-CLEAR Switching output MELD – not safe Protective function B: Violation of protec-
tive field

A-WF-VIO Switching output A1 Protective function A: Violation of warn-
ing field

B-WF-VIO Switching output EA1 Protective function B: Violation of warn-
ing field

A4.2P

B4.2P

A4.2W

B4.2W

1

2

3

4
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Table 5.4: Assignment of signals to switching outputs

5.2.6 One protective function – Multi configuration
Ten configuration banks each with ten changeover-capable field pairs for safety-related switching outputs 
OSSD-A. You can configure the resolution, DTS speed, start-up behavior and response time separately 
for each configuration bank. For the field pair changeover, see chapter 5.7.6 "Changeover of 10x ten field 
pairs".

• Manual restart when the configuration bank is changed over
• Safe, time-delayed switch-off of safety-related switching outputs OSSD-B.

Examples of use: 
• Machine with multiple operating modes
• DTS with different speed levels and multiple load states

5.2.7 Two protective functions - multi configuration
In this function mode, you configure the protective functions for safety-related switching outputs OSSD-A 
and OSSD-B. 

• For each protective function, you can define five configuration banks each with ten field pairs. 
For the field pair changeover, see chapter 5.7 "Field pair changeover".

• You can configure the safety parameters separately for each configuration bank. 
• For each configuration bank, field pair actuation and field pair changeover take place together for the 

field pairs of protective function A (A1.1 to A5.10) and protective function B (B1.1 to B5.10).
If, for example, the control system in configuration bank 2 actuates the field pair A2.5 for protective 
function A, the field pair B2.5 for protective function B is also actuated.

Logic signal Electrical switching output Description

OSSD A Safety-related switching outputs 
OSSD A

Protective function A: Violation of protec-
tive field

OSSD B Safety-related switching outputs 
OSSD B

Protective function B: Violation of protec-
tive field

A-WF-VIO Switching output A1 or A3 Protective function A: Violation of warning 
field

B-WF-VIO Switching output A2 or A4 Protective function B: Violation of warning 
field
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5.3 Selectable resolution for hand, leg and body detection
The application-specific resolution of the safety sensor is defined in the configuration project together for 
all protective/warning field pairs of a configuration bank. 

Table 5.5: Resolution of the safety sensor depending on the function

5.4 Speed-dependent protective function for vehicles
For object detection in the case of mobile applications, the safety sensor evaluates the relative speed of 
the object. If the safety sensor is mounted on vehicles or on moving parts of machines, the maximum 
speed of the vehicle must be entered during configuration of the protective function.
The maximum vehicle speed (Max. DTS speed) is selected in the configuration project together for all 
protective/warning field pairs of a configuration bank.

5.5 Response time
The response time is the maximum time from a protective field violation to switch-off of the safety-related 
switching outputs.
The response time is selected in the configuration project together for all protective/warning field pairs of 
a configuration bank.

5.6 Configurable start-up behavior
The start-up behavior is selected in the configuration project together for all protective/warning field pairs 
of a configuration bank.

5.6.1 Automatic start/restart
The machine starts automatically as soon as the machine is switched on or the supply voltage returns and 
when the protective field is free again.

Using automatic start/restart

You can use the automatic start/restart function under the following prerequisites:
• The start/restart interlock function is taken over by a downstream safety-related component of the 

machine control system.
or

• It is not possible to walk behind or go around the effective protective field.

Safety sensor resolution 
[mm]

Function Application(s)

30 Hand detection Point of operation guarding

40 Arm detection Point of operation guarding

50 Leg detection with the safety sensor 
mounted close to floor level 

Danger zone guarding

60 Leg detection
• Mounting height 150 mm
• Mounting height = Height of the 

scan level above floor level

Danger zone guarding

70 • Leg detection with the safety sen-
sor mounted at a height of 
300 mm

• Leg detection and detection of 
lying persons in the case of 
mounting on vehicles 
Mounting height approx. 200 mm

Stationary danger zone guarding
Mobile danger zone guarding

150 Body detection Access guarding
Mobile side guarding
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 Allow for an optical and/or acoustic start warning. 

Automatic start-up
The automatic start-up function starts the machine automatically as soon as the supply voltage is present. 

Automatic restart
The automatic restart function starts the machine automatically as soon as the protective field is free again.

5.6.2 Start interlock/automatic restart
With start interlock/automatic restart, the safety sensor remains in the OFF state when, following a power 
supply interruption, the voltage supply is restored. After violation of the protective field, the system restarts 
when the protective field is free again.

The start/restart interlock has two functions:
• Start interlock
• Automatic restart

Using start interlock/automatic restart
 In addition to the safety sensor you must also install the reset button. The machine operator starts the 

machine with this reset button. 
 Position the reset button outside the danger zone so that it cannot be activated from the protective fields 

and danger zones. The operator must be able to see all danger zones from this position.
 Identify the area to be released on the reset button so that its meaning is clear and easy to understand.
 Ensure that nobody is in the danger zone before pressing the reset button.
 Hold down the reset button for between 0.12 s and 4 s to enable the safety-related switching outputs.

Start interlock
The start interlock function prevents the machine from starting automatically after switching on or after the 
supply voltage returns. 
The machine only starts when you press the reset button.

Automatic restart
The automatic restart function starts the machine automatically as soon as the protective field is free again.

5.6.3 Start/restart interlock (RES)
When accessing the protective field, the start/restart interlock ensures that the safety sensor remains in 
the OFF state after the protective field has been cleared. It prevents automatic release of the safety circuits 
and automatic start-up of the system, e.g. if the protective field is again clear or if an interruption in the 
voltage supply is restored.

The start/restart interlock has two functions:
• Start interlock
• Restart interlock

Using start/restart interlock
 In addition to the safety sensor you must also install the reset button. The machine operator starts the 

machine with this reset button. 

DANGER
Risk of death if start-up is operated unintentionally!
 Ensure that the reset button for unlocking the start interlock cannot be reached from the danger zone.
 Before unlocking the start interlock, make certain that no people are in the danger zone.

For access guarding, the start/restart interlock function is mandatory. The protective device may            
only be operated without start/restart interlock in certain exceptional cases and under certain            
conditions acc. to ISO 12100.
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 Position the reset button outside the danger zone so that it cannot be activated from the protective fields 
and danger zones. The operator must be able to see all danger zones from this position.

 Identify the area to be released on the reset button so that its meaning is clear and easy to understand.
 Ensure that nobody is in the danger zone before pressing the reset button.
 Hold down the reset button for between 0.12 s and 4 s to enable the safety-related switching outputs.

Start interlock
The start interlock function prevents the machine from starting automatically after switching on or after the 
supply voltage returns. 
The machine only starts when you press the reset button.

Restart interlock
The restart interlock function prevents the machine from starting automatically, as soon as the protective 
field is free again. The restart interlock function always includes the start interlock function.
The machine only starts again when you press the reset button.

5.7 Field pair changeover
The safety sensor has 10x ten field pairs or 100 field pairs. Switchover between the field pairs is possible 
at all times, provided the operating situation allows this.
The information for field pair changeover applies both for the field pairs of protective function A and for the 
field pairs of protective function B. 
Use the field pair changeover when the danger zones vary depending on the activity of the machine or the 
operating state, e.g. driverless transportation system (DTSs), to control the field pair changeover for 
straight and curved stretches.
If the rules for field pair changeover are not complied with, the safety sensor signals a fault and the safety-
related switching outputs are switched off.

The safety sensor has the following modes for field pair activation and field pair changeover:
• Fixed selection of one field pair
• Selection by signal inputs with the changeover mode Overlapped monitoring
• Selection by signal inputs with the changeover mode Fixed changeover moment

Field pair activation and field pair changeover are configured via the protective function, e.g. CONFIGU-
RATION > Protective function A > MODE FOR FIELD PAIR ACTIVATION AND CHANGEOVER.
The field pair changeover can be monitored by means of configurable measures (see chapter 5.8 "Moni-
toring of field pair changeover").
During the changeover process, the safety sensor monitors the field pair active before the field pair 
changeover, according to the configured changeover mode and changeover time.

Using field pair changeover
You can configure and switch over the field pairs according to the different requirements. The field pairs 
are changed over via the corresponding control inputs.
The rules for field pair changeover depend on the changeover mode and changeover time. The activated 
field pair must correspond with the respective operating mode. The time of the field pair changeover must 
correspond with the machine's risk assessment. You must take the lead time, braking distances, response 
times and machine stopping times, e.g. influenced by overlapping protective fields, into account.
If the rules are not observed, the safety-related switching outputs switch off and a message is displayed 
(see chapter 12 "Diagnostics and troubleshooting").

DANGER
Risk of death if start/restart is operated unintentionally!
 Ensure that the reset button for unlocking the start/restart interlock cannot be reached from the danger 

zone.
 Before unlocking the start/restart interlock, make certain that no people are in the danger zone.
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The following rules apply for the field pair changeover: 
• The field pair changeover performed by the control system must agree with the safety sensor's con-

figuration. This configuration is specified with the configuration and diagnostics software (see 
chapter 9.4 "Configuring protective function"). 

• With field pair changeover to an occupied protective field, the safety sensor only switches off the 
safety-related switching outputs after the set response time plus a synchronization time of 40 ms. 

5.7.1 Fixed selection of one field pair
If Fixed selection of one field pair is set as the mode for field pair activation, field pair A1.1 is monitored 
irrespective of how the control inputs are connected.

5.7.2 Changeover of five field pairs in changeover mode "Overlapped monitoring"
Changeover mode Overlapped monitoring: This changeover mode is only permitted for up to five field 
pairs.
The field pair changeover must take place within a configurable time period of the changeover time. Two 
field pairs can be monitored simultaneously during the changeover time.

• First the control unit must switch to a new field pair before it switches off the previously active one.
• A maximum of two field pairs are active.

Each field pair is then only active if it is selected by the control unit.
• The changeover time starts when the second field pair is connected. When the changeover time has 

expired, only one field pair should still be active.
• The changeover time is specified with the configuration and diagnostics software (see chapter 9.4.4 

"Creating and configuring protective/warning field pairs").

Table 5.6: Connection of control inputs F1 to F5 with activation of field pairs A1.1 to A1.5 for 
protective function A

In the case of two protective functions, connection of control inputs F6 to F10 applies analogously for acti-
vation of field pairs B1.1 to B1.5 for protective function B.

NOTICE
Take the lead time into consideration!
 Take the lead time of the changeover time and response time into consideration before operating the 

machine in its new operating situation.

Field pair Control input Description

F1 F2 F3 F4 F5

A1.1 1 0 0 0 0 Field pair A1.1 is active

A1.2 0 1 0 0 0 Field pair A1.2 is active

A1.3 0 0 1 0 0 Field pair A1.3 is active

A1.4 0 0 0 1 0 Field pair A1.4 is active

A1.5 0 0 0 0 1 Field pair A1.5 is active
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1 Active protective field
2 An old protective field is active
3 Set changeover time
4 A new protective field is active
5 Changeover complete
PF Field pair or quad
X X Field pair changeover

Figure 5.3: Signal/time diagram: Overlapped monitoring

5.7.3 Changeover of ten field pairs in changeover mode "Fixed changeover moment"
Changeover mode Fixed changeover moment: The field pair changeover must take place within the 
configurable changeover time, i.e. after the changeover time has expired, a valid and stable input connec-
tion must be present. The old field pair is monitored during the changeover time. 

• The previously active field pair is monitored during the changeover time.
• The changeover time starts when the safety sensor registers a change at control inputs F1 to F5. 

When the changeover time has expired, only one field pair should still be active.
• Monitoring of the newly activated field pair starts when the changeover time has expired.
• The changeover time is specified with the configuration and diagnostics software (see chapter 9.4.4 

"Creating and configuring protective/warning field pairs").

Table 5.7: Connection of control inputs F1 to F5 with activation of field pairs A1.1 to A1.10 for 
protective function A

PF1.1

PF1.2

PFA…

PFA.x

1

2 3
5

4

0

1

A1.2

0

0

0

1

XX XX

0

1

0

0

A1.2 & A1.x A1.x

0

1

Field pair Control input Description

F1 F2 F3 F4 F5

A1.1 1 0 0 0 0 Field pair A1.1 is active

A1.2 0 1 0 0 0 Field pair A1.2 is active

A1.3 0 0 1 0 0 Field pair A1.3 is active

A1.4 0 0 0 1 0 Field pair A1.4 is active

A1.5 0 0 0 0 1 Field pair A1.5 is active

A1.6 1 1 1 1 0 Field pair A1.6 is active

A1.7 1 1 1 0 1 Field pair A1.7 is active
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In the case of two protective functions, connection of control inputs F6 to F10 applies analogously for acti-
vation of field pairs B1.1 to B1.10 for protective function B.

1 Active protective field
2 An old protective field is active
3 Set changeover time
4 A new protective field is active
5 Initiation of the field pair changeover caused by a change in the signal – the old protective field is 

monitored until the end of the changeover time
6 Fixed end – field pair changeover complete
7 … Only one field pair change
PF Field pair or quad
X X Field pair changeover

Figure 5.4: Signal/time diagram: Overlapped monitoring

A1.8 1 1 0 1 1 Field pair A1.8 is active

A1.9 1 0 1 1 1 Field pair A1.9 is active

A1.10 0 1 1 1 1 Field pair A1.10 is active

Field pair Control input Description

F1 F2 F3 F4 F5

2 3 4

PF1.1

PF1.2

PFA…

PFA.x

1

5

7

6

0 0

1

A1.2

0

0 0

1 1

1

XX

0 1

1 1

0

00 0

A1.2 A1.x

0

0

0

0

0

1
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5.7.4 Changeover of 100 field pairs
One protective function, one configuration bank

1 Configuration bank
2 Selection of field pairs A1.x via control inputs F1 to F5
3 Selection of field pairs Ay.1 via control inputs F6 to F10

Figure 5.5: Field pair matrix: Connection of control inputs F1 to F5 and F6 to F10 with activation of field 
pairs A1.1 to A10.10 for protective function A

5.7.5 Changeover of 2x ten field pairs
Two protective functions

• The connection of control inputs F1 … F5 controls the field pair changeover for protective function A 
(safety-related switching outputs OSSD-A)

• The connection of control inputs F6 … F10 controls the field pair changeover for protective function 
B (safety-related switching outputs OSSD-B)

• The connection of the control inputs corresponds to the changeover of ten field pairs for protective 
function A (field pairs A1.1 to A1.10) and ten field pairs for protective function B (field pairs B1.1 to 
B1.10); see chapter 5.7.3 "Changeover of ten field pairs in changeover mode "Fixed changeover 
moment"".

5.7.6 Changeover of 10x ten field pairs
Multi configuration: one protective function, ten configuration banks each with ten field pairs

Examples of use: 
• Machine with multiple operating modes (y)
• DTS with different speed levels (x; control inputs F1 to F5) and multiple load states (y; control inputs 

F6 to F10)

A1.1 A1.2 A1.3 A1.4 A1.5 A1.6 A1.7 A1.8 A1.9 A1.10

A2.1 A2.2 A2.3 A2.4 A2.5 A2.6 A2.7 A2.8 A2.9 A2.10

A3.1 A3.2 A3.3 A3.4 A3.5 A3.6 A3.7 A3.8 A3.9 A3.10

A4.1 A4.2 A4.3 A4.4 A4.5 A4.6 A4.7 A4.8 A4.9 A4.10

A5.1 A5.2 A5.3 A5.4 A5.5 A5.6 A5.7 A5.8 A5.9 A5.10

A6.1 A6.2 A6.3 A6.4 A6.5 A6.6 A6.7 A6.8 A6.9 A6.10

A7.1 A7.2 A7.3 A7.4 A7.5 A7.6 A7.7 A7.8 A7.9 A7.10

A8.1 A8.2 A8.3 A8.4 A8.5 A8.6 A8.7 A8.8 A8.9 A8.10

A9.1 A9.2 A9.3 A9.4 A9.5 A9.6 A9.7 A9.8 A9.9 A9.10

A10.1 A10.2 A10.3 A10.4 A10.5 A10.6 A10.7 A10.8 A10.9 A10.10

F5F4F3F2F1

F10
F9

F8
F7

F6

A1 A1.x

Ay.1

1

3

2
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1 Configuration banks
2 Field pair changeover within one configuration bank via control inputs F1 to F5
3 Changeover of the configuration banks via control inputs F6 to F10

Figure 5.6: Matrix of configuration banks/field pairs: Connection of control inputs F1 to F5 and F6 to F10 
with activation of field pairs A1.1 to A10.10 for protective function A

5.8 Monitoring of field pair changeover
The Changeover order function determines the permissible field pair changeovers, e.g. if field pair A1.3 
must be changed over to field pair A2.5. If the Changeover order function is active, the safety-related 
switching outputs (OSSDs) switch off in the following cases:

• the control initiates an impermissible field pair changeover.
• the field pair to which the system is changed over has been deactivated.

Activating the function
 The Changeover order is defined using the configuration and diagnostics software (see chapter 9.5 

"Defining permissible field pair changeovers").

5.9 Reference contour monitoring
The reference contour monitoring function prevents unintentional misalignment and deliberate manipula-
tion of the safety sensor. If a protective field contains an area with reference contour, the safety sensor not 
only monitors interruptions of the protective field, it also monitors the concurrence of the measured area 
contour with the set reference contour. If the measurement values of the area contour deviate from the 
defined reference contour by more than the tolerance zone of 200 mm, i.e., if no object is detected in the 
area with reference contour, the safety sensor switches off and the safety-related switching outputs 
(OSSDs) switch to off. 

Activation of the function
 Activate the Reference contour monitoring function together with the definition of the protective field 

boundaries using the configuration and diagnostics software (see chapter 9.4.4 "Creating and configur-
ing protective/warning field pairs").

5.10 Field pair monitoring
The Field pair monitoring function is used to set the monitoring mode for the selected field pair.
The Standby request monitoring mode is used to switch off field pair monitoring and the safety-related 
switching outputs (OSSDs). This is advisable when parking vehicles, for example.

Activation of the function
 Activate field pair monitoring in the configuration and diagnostics software (see chapter 9.4.5 "Config-

uring field pair monitoring").

A1.1 A1.2 A1.3 A1.4 A1.5 A1.6 A1.7 A1.8 A1.9 A1.10

A2.1 A2.2 A2.3 A2.4 A2.5 A2.6 A2.7 A2.8 A2.9 A2.10

A3.1 A3.2 A3.3 A3.4 A3.5 A3.6 A3.7 A3.8 A3.9 A3.10

A4.1 A4.2 A4.3 A4.4 A4.5 A4.6 A4.7 A4.8 A4.9 A4.10

A5.1 A5.2 A5.3 A5.4 A5.5 A5.6 A5.7 A5.8 A5.9 A5.10

A6.1 A6.2 A6.3 A6.4 A6.5 A6.6 A6.7 A6.8 A6.9 A6.10

A7.1 A7.2 A7.3 A7.4 A7.5 A7.6 A7.7 A7.8 A7.9 A7.10

A8.1 A8.2 A8.3 A8.4 A8.5 A8.6 A8.7 A8.8 A8.9 A8.10

A9.1 A9.2 A9.3 A9.4 A9.5 A9.6 A9.7 A9.8 A9.9 A9.10

A10.1 A10.2 A10.3 A10.4 A10.5 A10.6 A10.7 A10.8 A10.9 A10.10

F5F4F3F2F1

F10
F9

F8
F7

F6

A1

A2

A3

A4

A5

A6

A7
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A10

A1.x
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3

1
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5.11 Internal safe time delay
In the One protective function function mode, you can use the OSSD B safety-related switching outputs 
for a second time-delayed switching function, e.g. for an emergency mechanism following controlled 
switch-off via the OSSD A safety-related switching outputs.

Activation of the function
 Activate the internal safe time delay and the switch off delay time in the configuration and diagnostics 

software (see chapter 9.4.3 "Activating protective function and contactor monitoring").

5.12 EDM contactor monitoring
The EDM contactor monitoring function dynamically monitors the contactors, relays or valves connected 
downstream of the safety sensor. Prerequisites for this are switching elements with positive-guided feed-
back contacts (normally closed contact).

Activation of the function
 Activate the contactor monitoring function using the configuration and diagnostics software (see 

chapter 9.4 "Configuring protective function").
If contactor monitoring is activated, it operates dynamically, i.e., in addition to monitoring the closed feed-
back circuit every time before the OSSDs are switched on, it also checks whether the feedback circuit has 
opened within 500 ms after release and whether it has closed again within 500 ms after the OSSDs 
switched off. If this is not the case, the OSSDs return to the OFF state after being switched on briefly. 
A message is displayed on the alphanumerical display and the safety sensor switches to the fault interlock 
state:

• With the OSSDs switched off, +24 V must be present at the EDM input.
• With the OSSDs switched on, the EDM circuit must be open (high impedance).

5.13 E-Stop linkage
Through linkage, the behavior of the safety sensor can be controlled via a two-channel safety circuit.
The upstream safety devices and operational controls perform safety-relevant switch-off of the safety-
related switching outputs of the safety sensor.

The following upstream sensors and operational controls are possible regarding the linkage:
• Safety device with two-channel contact-based switching output (normal closed contact), e.g. safety 

switch, E-Stop rope switch, safety position switch and the like (see chapter 5.13.1 "Contact-based 
safety circuit").

• Safety device with two-channel electronic OSSD switching output (see chapter 5.13.2 "Linking of 
electronic safety-related switching outputs").

E-Stop buttons connected to the safety sensor act only on the safety circuit to which the AOPD is assigned. 
Thus, it can be considered to be an area E-Stop. The regulations for E-Stops apply to it, including those 
in accordance with EN 60204-1 and EN ISO 13850, among others.
  In this case, observe the regulations for E-Stops.
If linkage is utilized, the response time of the linked device is extended by 20 ms.
 Take the extended response time into account when calculating the safety distance.

If the protective function is required, restarting is not possible until the set delay time has expired.

NOTICE
Extended response time in combination with an internal safe switching delay!
If the E-Stop linkage is used in combination with the internal safe time delay (see chapter 5.11 "Internal 
safe time delay"), the response time of the delayed switch-off increases by up to 40 ms.
 Take the extended response time of the delayed switch-off into account when configuring the system.



Functions

Leuze electronic RSL 440 45

5.13.1 Contact-based safety circuit
This function switches off the safety-related switching outputs of the safety sensor by means of an 
upstream 2-channel contact-based safety circuit, e.g. by means of safety switches with separate actuators.

The safety sensor only switches on if the following conditions have been fulfilled:
• The protective field is free.
• The safety circuit is closed or both contacts have been closed simultaneously within 0.5 s.

Activation of the function
 Activate the linkage using the configuration and diagnostics software (see chapter 9.4.3 "Activating pro-

tective function and contactor monitoring").

5.13.2 Linking of electronic safety-related switching outputs
This function is used to construct a serial connection of devices with electronic safety OSSD switching 
outputs. The OSSDs of an upstream safety device switch off the safety-related switching outputs of the 
safety sensor as a central safety device. Regarding the downstream safety circuit, a linked system 
behaves like a single device, i.e. only inputs are necessary in the downstream safety relay.

The following conditions have to be fulfilled for the OSSDs to switch on:
• The protective field must be free.
• The OSSDs of the upstream device must be switched on or have been switched on simultaneously 

within 0.5 s.

Activation of the function
 Activate the linkage using the configuration and diagnostics software (see chapter 9.4.3 "Activating pro-

tective function and contactor monitoring").

5.14 Signaling functions
The device and monitoring functions of the safety sensor deliver indication signals for the following function 
groups:

• Protective functions, e.g.

• Protective field violated
• Warning field violated
• Field pair changeover active

• Device functions
• Error messages
• Warnings
• Diagnosis

The assignment of the individual functions within the function groups to the indication signals is defined 
using the configuration and diagnostics software (see chapter 9.6 "Configuring signal outputs").
For an overview of all logic and electrical signals of the safety sensor, see chapter 15.4 "Representation 
of safety sensor status".

A contact-based safety sensor, for example a safety switch with two positive-guided normal            
closed contacts, can be switched in the safety circuit when linking electronic safety-related            
switching outputs. If this switch opens, it must close both circuits again simultaneously within a              
time tolerance of 0.5 s. A message will otherwise be displayed on the safety sensor.
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6 Applications
The following chapters essentially describe the safety sensor's usage possibilities. 

• To safely mount the safety sensor for the respective application, see chapter 7 "Mounting".
• For the electrical connection of the safety sensor, see chapter 8 "Electrical connection".
• To safely configure the safety sensor for the respective application, see chapter 9 "Configuring the 

safety sensor".

6.1 Stationary danger zone guarding
Stationary danger zone guarding enables a very spacious protection of people on machines that are to 
remain as accessible as much as possible. The safety sensor is applied as a stop-activating and presence-
detecting protective device. The safety sensor's protective field is set up horizontally in front of the machine 
or system's point of operation.
You can also use the stationary danger zone guarding if you do have to guard areas under the machine 
or at the rear that are not visible. 
If the danger zone changes during operation, the respective danger zone is guarded by means of a field 
pair changeover while the working area is accessible.

1 Safety sensor
2 Danger zone, protective function activated

Figure 6.1: Stationary danger zone guarding

Guarding of two danger zones
The safety sensor allows two danger zones to be guarded simultaneously and independently. The 
dangerous machine or system parts (e.g. different movement areas of robots, telpher line) are actuated 
separately. If a protective field violation occurs, only the movement of the affected part of the system is 
stopped. 
The protective function for each danger zone is defined separately using the configuration and diagnostics 
software (see chapter 9.4 "Configuring protective function").

2

1
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1 Safety sensor
2 Danger zone 1, protective function activated
3 Danger zone 2, protective function deactivated

Figure 6.2: Stationary danger zone guarding for two danger zones

6.2 Stationary point of operation guarding
Hand and arm protection are always required when people must work at the point of operation. The safety 
sensor is applied as a stop-activating and presence-detecting protective device. The safety sensor's 
protective field is set up vertically in front of the machine or system's point of operation. In accordance with 
EN ISO 13855, resolutions from 14 to 40 mm make sense here. This yields the necessary safety distance 
for finger protection, among others (see chapter 7.3 "Stationary point of operation guarding"). 

6.3 Stationary access guarding
Stationary access guarding protects people that step into a danger zone. The vertically aligned protective 
field of the safety sensor detects the passage of a person. A side post and the floor serve as reference 
contour for monitoring the position of the protective field. In contrast to danger zone guarding, the safety 
sensor no longer registers a person in the danger zone after the passage. This is why the start/restart inter-
lock function is vital for access guarding.

2 1

3
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1 Safety sensor
2 Reference contour
3 Danger zone 1, protective function activated
4 Danger zone 2, protective function deactivated

Figure 6.3: Stationary access guarding

6.4 Mobile danger zone guarding
Mobile danger zone guarding protects people that are located in the transportation path of a driverless 
transportation system (DTS). The distance between the protective field front edge and the vehicle front 
must be greater than the stopping distance of the vehicle with selected speed and maximum load. A safe 
control system selects speed-dependent protective fields and can activate side horizontal protective fields 
for curved stretches. 

1
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1 Warning field for forward travel
2 Protective field 1 for forward travel, deactivated
3 Protective field 2 for forward travel, activated
4 Protective field 1 for reverse travel, activated
5 Protective field 2 for reverse travel, deactivated
6 Warning field for reverse travel

Figure 6.4: Mobile danger zone guarding
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1 Warning field for forward travel
2 Protective field 1 for forward travel, deactivated
3 Protective field 2 for forward travel, activated
4 Protective field 1 for reverse travel, activated
5 Protective field 2 for reverse travel, deactivated
6 Warning field for reverse travel

Figure 6.5: Mobile danger zone guarding

6.5 Danger zone guarding on side-tracking skates
Side-tracking skate guarding
Side-tracking skate guarding protects personnel who are located in the transportation path of a transverse 
side-tracking skate (TSS). One safety sensor is mounted in each direction of travel. The safety sensor that 
is mounted opposite the current direction of travel is deactivated. Evaluation of the warning field allows the 
transverse side-tracking skate to be braked gently. To ensure optimum material transport, the control 
changes over the protective/warning field pair depending on the state and speed. 

Mobile side guarding
Mobile side guarding protects people and objects that are located on the vehicles path. This application is 
used when very low arranged roller conveyors do not permit an unobstructed passage of horizontal, lateral 
protrude protective fields. The safety sensors are positioned laterally and the protective fields are arranged 
vertically, at a slight tilt. The position of the front edges of the side protective fields is oriented here on the 
position of the front edge of the horizontal protective field.

1

2

6 5

3

4



Applications

Leuze electronic RSL 440 51

1 Protective and warning field pair for forward travel, activated
2 Protective and warning field pair for side guarding, left, activated
3 Protective and warning field pair for side guarding, right, activated
4 Protective and warning field pair for reverse travel, deactivated

Figure 6.6: Mobile side guarding on side-tracking skates
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7 Mounting
The safety sensor's protective function is only guaranteed when the device arrangement, configuration, 
protective field dimensioning and mounting are coordinated with the respective application.
The installation work must only be performed by a competent person in compliance with the applicable 
standards and these instructions. The mounting must be thoroughly inspected on completion.
 You must observe and comply with the respective relevant machine-specific standards and regulations 

(see chapter 16 "Standards and legal regulations").
 Observe the basic information on mounting (see chapter 7.1 "Basic infos").

7.1 Basic infos

7.1.1 Calculation of safety distance S
Optical protective devices can only perform their protective function if they are mounted with adequate 
safety distance. When mounting, all delay times must be taken into account, such as the response times 
of the safety sensor and control elements as well as the stopping time of the machine, among others.
The following standards specify calculation formulas:

• EN ISO 13855, "Safety of machines - The positioning of protective device in respect of approach 
speeds of parts of the human body": mounting situation and safety distances

General formula for calculating the safety distance S of an Optoelectronic Protective Device acc. to              
EN ISO 13855:

S [mm] = Safety distance
K [mm/s] = Approach speed
T [s] = Total time of the delay, sum from (ta + ti + tm)
ta [s] = Response time of the protective device
ti [s] = Response time of the safety relay
tm [s] = Machine stopping time
C [mm] = Additional distance to the safety distance

WARNING
Improper mounting may result in serious injury!
The protective function of the safety sensor is only ensured if appropriately and professionally mounted 
for the respective, intended area of application.
 Only allow competent persons to install the safety sensor.
Maintain the necessary safety distances (see chapter 7.1.1 "Calculation of safety distance S").
Make sure that stepping behind, crawling under or stepping over the protective device is reliably ruled 

out and reaching under, over or around is taken into account in the safety distance, if applicable with 
additional distance CRO corresponding to EN ISO 13855.

 Take measures to prevent that the safety sensor can be used to gain access to the danger zone, e.g. 
by stepping or climbing into it.

 Observe the relevant standards, regulations and these instructions.
 After mounting, check the safety sensor for proper function.
 Clean the safety sensor at regular intervals.

Environmental conditions: see chapter 15 "Technical data"
Care: see chapter 13 "Care, maintenance and disposal"

If longer stopping times are determined during regular inspections, an appropriate additional time            
must be added to tm.

S K T C+=
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7.1.2 Suitable mounting locations
Area of application: Mounting
Tester: technician who mounts the safety sensor

Table 7.1: Checklist for mounting preparations

7.1.3 Mounting the safety sensor

Proceed as follows:
 Calculate the necessary safety distance and determine the required additional distances for your appli-

cation.
 Determine the mounting location.

• Observe the information regarding the mounting locations; see chapter 7.1.2 "Suitable mounting 
locations".

• Ensure that machine parts, safety guards or covers do not impair the safety sensor's field of vision.
• Make sure that the scanning range of the safety sensor is not limited. To mount the safety sensor 

taking the scanning range into consideration, a template must be attached to the top cover of the 
safety sensor.

Check: Yes No

Is the safety distance to the point of operation maintained?

Has the scanning angle of the safety sensor as given on the marking/template on the top 
of the sensor been taken into consideration?

Can the point of operation or the danger zone only be accessed through the protective 
field?

Have measures been taken to prevent the protective field from being bypassed by crawl-
ing under?

Is stepping behind the protective device prevented or is mechanical protection available?

Can the safety sensors be fastened in such a way that they cannot be moved and 
turned?

Is the safety sensor accessible for testing and replacing?

Is it impossible to actuate the reset button from within the danger zone?

Can the entire danger zone be seen from the installation site of the reset button?

If you answer one of the items on the checklist (see table 7.1) with no, the mounting location must                  
be changed. 

Detailed information on mounting the safety sensor can be found in the document “Quick Start              
Guide RSL 400”.
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all dimensions in mm
1 Safety sensor
2 Template (markings on safety sensor)
3 Mounting location
4 Reference point for distance measurement and protective field radius
5 Area with unobstructed view; must remain free

Figure 7.1: Mounting taking the scanning range of 270° into consideration

all dimensions in mm
1 Scan level
2 Area with unobstructed view; must remain free (40 mm)

Figure 7.2: Mounting: area with unobstructed view

 Determine whether you are going to install the safety sensor with or without the mounting system.
During mounting, use the four supplied M5 screws or four similar screws with a diameter of 5 mm, and 
make certain that the mounting elements or mounting construction supports at least four times the 
weight of the device with or without mounting system.

 Have the appropriate tools at the ready and mount the safety sensor.
 Install protective enclosures or safety bars if the safety sensor is in an exposed position. 
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 If there is a risk that the safety sensor will be used as a climbing aid, install a suitable physical cover 
over the safety sensor. 

 Align the mounted safety sensor horizontally and vertically using the integrated electronic spirit level.

• For the electronic spirit level to work, the supply voltage of 24 V must be present at the safety sensor. 
• The electronic spirit level indicates the vertical (V) and horizontal (H) alignment of the safety sensor.

The spirit level is displayed
• permanently after the end of the booting phase/start phase when starting without configuration
• repeatedly until the end of the booting phase/start phase when starting with configuration
• using the configuration and diagnostics software: 

Diagnosis > [Align sensor mechanically] button ( )

• When mounting without a mounting system, the safety sensor can be aligned only slightly along the 
horizontal axis.

 Attach safety notice stickers to the mounted safety sensor (the stickers are included in the delivery con-
tents).

 Configure the safety sensor with the configuration and diagnostics software; see chapter 9 "Configuring 
the safety sensor": 

• Observe the information on the response times, the stopping time of the machine and the protective 
field dimensioning for your application.

• Determine the size of the protective field on the basis of the mounting location, the calculated safety 
distances and additional distances.

• Configure the protective field so that the safety-related switching outputs are switched off from every 
accessible point with sufficient minimum distance D. 

• Determine the start-up/restart operating mode required for the application.
• If you are using start and/or restart interlock, determine the position for the reset button. 
• Many safety-relevant parameters are preset for each application in the configuration and diagnostics 

software. Use these preset values where possible.
• Determine the conditions for the field pair changeover and the sequence of the field pair changeover. 

 Create a record document for the device configuration and protective field dimensioning. 

• The document must be signed by the person responsible for the configuration. 
• Include this document with the machine documentation. 

Mark the protective field boundaries on the floor. 
You can easily test the safety sensor along this marking.

After mounting, you can electrically connect (see chapter 8 "Electrical connection"), start up, align (see 
chapter 10 "Starting up the device"), and check (see chapter 11 "Testing") the safety sensor.
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7.1.4 Mounting examples

all dimensions in mm
1 Safety sensor
2 Post
3 Mounting bracket BT856M

Figure 7.3: Example: mounting on a post

all dimensions in mm
1 Safety sensor
2 Mounting bracket BT840M

Figure 7.4: Example: mounting on a chamfered corner
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1 Mounting bracket BTF815M (only in combination with the mounting system BTU800M)
2 Mounting system BTU800M
3 Safety sensor

Figure 7.5: Example: mounting on floor

7.1.5 Information on protective field dimensioning
 Dimension the protective field big enough that the safety sensor's switching signal can stop the danger-

ous movement in good time. 
If several protective fields are selected with field pair changeover, this condition applies for all protective 
fields.
Protective fields with a radius of less than 200 mm (safety sensor short range) are not permitted and 
are therefore preset as minimum contour. 

 If you cannot sufficiently dimension a protective field, use additional protective measures, e.g. safety 
guards. 

 Ensure that the protective field cannot be walked behind in the direction of the danger zone.
 Observe all delay times, e.g. safety sensor response times, control element response times, braking 

times or machine or driverless transportation system stopping times (DTS).
 Take changed delay times, which, for example, can be caused by reducing the braking force, into 

account.
 Observe shadowing effects, e.g. surfaces and areas behind static objects. People in the shadows of 

these objects will not be detected by the safety sensor.
 Observe the lateral tolerance when dimensioning the protective fields (see chapter 15 "Technical data").
 Do not use cone-shaped protective field contours, as these do not guarantee any protective function. 
 Take the additional distances required for the application into account. 

Handling unmonitored areas
There is an area behind the safety sensor that the safety sensor does not monitor. Unmonitored areas can 
also materialize, e.g. if you install a safety sensor on a rounded off vehicle front. 
It must not be possible to walk behind unmonitored areas. 

2 3

1
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1 Safety sensor
2 Protective field
3 Unmonitored area;
 optimum availability at a distance of 50 mm to fixed contours

Figure 7.6: Unmonitored area

 Prevent access to an unmonitored area with screens.
 Prevent walking behind by countersinking the safety sensor into the machine contour. 

1 Countersinking into the machine contour, min. 100 mm
2 Minimum distance above the scanner unit, min. 34 mm
3 Protective field
4 Safety sensor
5 Machine
6 Angled physical cover

Figure 7.7: Stepping behind protection by countersinking into the machine contour

 Use a physical cover set at an angle over the safety sensor if you expect that the safety sensor will be 
used as a climbing aid or standing surface. 
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Protective field setup with adjacent safety sensors
The safety sensor has been developed in a way that prevents several safety sensors from interfering with 
one another as much as possible. Nevertheless, if several safety sensors are positioned adjacent to each 
other, this may result in a reduction in the availability of the safety sensors.
 Plan for shielding with stationary applications. 

The shielding must be at least as high as the safety sensor's optics cover and embedded with the front 
housing edge. 
If you plan for a shielding that is still within the countersinking in the machine contour, the resolution of 
the protective fields must not be impaired at any accessible points. 
You require the reciprocal shielding with both horizontal and vertical alignment of the protective fields. 

1 Point of operation
2 Safety sensor
3 Machine with countersinking for sensor installation
4 Protective fields
5 Shielding

Figure 7.8: Shielding prevents reciprocal influencing of safety sensors set up beside one another

 Install the safety sensors off-set on the height.

1 Minimum distance, min. 100 mm
2 Scan level

Figure 7.9: Height offset mounting, parallel alignment

 Install the safety sensors with crossed alignment.
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1 Scan level
Figure 7.10: Mounting beside one another, without height offset, crossed alignment

1 Scan level
Figure 7.11: Mutually opposing mounting, without height offset, crossed alignment

7.2 Stationary danger zone guarding
The safety sensor takes over the stop-activating and presence-detecting function.

Calculation of safety distance S for parallel approach to the protective field

S [mm] = Safety distance
K [mm/s] = Approach speed for danger zone guarding with approach direction parallel to the pro-

tective field (resolution up to 90 mm): 1600 mm/s
T [s] = Total time of the delay, sum from (ta + ti + tm)
ta [s] = Response time of the protective device
ti [s] = Response time of the safety relay
tm [s] = Machine stopping time
C [mm] = Additional distance for danger zone guarding with approach reaction H = height of the 

protective field, Hmin = minimum installation height permitted, but no smaller than 0, 
d = resolution of the protective device C = 1200 mm - 0.4  H; Hmin = 15  (d - 50) 

Response times, stopping time of the machine
The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. At least 
two consecutive scans must be interrupted so that the safety-related switching outputs switch off. The 
safety sensor's minimum response time is therefore 80 ms.
If you want to increase the safety sensor's availability in an environment with fine particles, increase the 
number of interrupted scans after which the safety-related switching outputs switch off. With each addi-
tional scan the response time ta increases by 40 ms. With K = 1600 mm/s the safety distance increases by 
64 mm per additional scan. 
 Select a response time ta of at least 120 ms or higher. 
 Determine the machine/system's stopping time tm. 

If data is not available, you can commission Leuze electronic to perform measurements; see chapter 14 
"Service and support".

 If an increase in the stopping time within the regular test periods is to be expected, take an additional 
time into account for the machine's stopping time tm. 

11

11
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Additional distance C for danger zone guarding with approach reaction
You prevent reaching the point of operation by reaching over with the additional distance C:

H [mm] = Height of protective field above floor (installation height)
CMIN [mm] = 850 mm
HMAX [mm] = 1000 mm

The minimum permissible installation height depends on the resolution of the safety sensor:

Table 7.2: Additional distance C depending on the resolution of the safety sensor

Application-related additional distances for safety distance S
The protective field boundaries must be defined so that the calculated safety distance S to the point of 
operation, extended by the additional distances, is complied with everywhere. Where this is not possible 
or does not make sense, you can use hard guards as supplementary measures.

1 Routing machine with free space for sensor protective field in the area under the machine table
2 Safety sensor
3 Protective field contour
4 Warning field contour
S Calculated safety distance S
D Minimum distance D (= safety distance S + additional distance ZSM + ZREFL, where required)
RG Largest protective field radius without additional distances, measured from the rotation axis of the 

rotary mirror
Figure 7.12: Defining the protective field contour for a stationary, horizontal protective field

 Define the limits of the protective field using the safety distance S without an additional distance.
 Determine the biggest protective field radius RG for this protective field. 

C 1200 0 4 H–=

Safety sensor resolution (mm) Minimum permissible installa-
tion height (mm)

Additional distance C (mm)

50 0 1200

60 150 1140

70 300 1080

S D

D
S

RG DS
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The biggest protective field radius determines the additional distance ZSM for the system-related mea-
surement error, by which the protective field contour must be enlarged.
The position of the rotary mirror's center point with regard to the housing is provided by the dimensioned 
drawings. 

Table 7.3: Additional distance ZSM for the protective field contour because of measurement error

 Avoid retro-reflectors at the beam level beyond the protective field boundaries. If this is not possible, 
add another additional distance ZREFL of 100 mm.

Minimum distance D to the protective field contour
The minimum distance D is the distance between point of operation and protective field contour.

D [mm] = Minimum distance between the point of operation and the protective field contour
ZSM [mm] = Additional distance for system-related measurement error
ZREFL [mm] = Additional distance for retro-reflectors

 If the protective field runs up against fixed boundaries, such as walls or machine frames, take a coun-
tersinking into the machine contour of at least the size of the necessary additional distance ZSM, and ZREFL 
where required, into account. With the protective field contour under these conditions, stay about 50 mm 
away from the machine surface.

 If the protective field runs up against hard guards, ensure that the protective field ends under instead of 
in front of the hard guards. The width of the lower post must correspond with the size of the required 
additional distances.

 If all hazards in the fenced off area are covered by the safety sensor and the height of the beam level 
is 300 mm, you can raise the bottom edge of the hard guards from 200 mm to 350 mm. The protective 
field reaching to under the hard guards takes over the protective function of preventing an adult from 
crawling under in this case.

 Prevent obstructions within the calculated protective field boundaries. If this is not possible, implement 
protective measures so that the point of operation cannot be reached from out of the shadow of the 
obstruction. 

7.3 Stationary point of operation guarding
The safety sensor takes over the stop-activating and presence-detecting function.

Biggest protective field radius RG without additional  
distances

Additional 
distance ZSM

< 6.25 m 100 mm

> 6.25 m 120 mm

The beam level of the safety sensor is level with the alphanumerical display.

D S ZSM ZREFL+ +=
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Calculation of safety distance SRO for access over the vertical protective field

SRO [mm] = Safety distance
K [mm/s] = Approach speed for point of operation guarding with approach reaction and normal 

approach direction to the protective field (resolution 14 to 40 mm): 2000 mm/s 
or 1600 mm/s, when SRO > 500 mm

T [s] = Total time of the delay, sum from (ta + ti + tm)
ta [s] = Response time of the protective device
ti [s] = Response time of the safety relay
tm [s] = Machine stopping time
CRO [mm] = Additional distance in which a body part can move towards the protective device before 

the protective device triggers.

Response times, stopping time of the machine
The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. With each 
additional scan the response time ta increases by 40 ms. With K = 2000 mm/s approach speed this corre-
sponds with an increase in the safety distance of 80 mm per additional scan. With K = 1600 mm/s it is 
64 mm.
 Select a response time ta of at least 80 ms or higher. 
 Determine the machine/system's stopping time tm. 

If data is not available, you can commission Leuze electronic to perform measurements (see chapter 14 
"Service and support").

 If an increase in the stopping time within the regular test periods is to be expected, take an additional 
time into account for the machine's stopping time tm. 

Additional distance CR0 for finger protection

The required finger protection is ensured here by an additional distance C, which depends on the safety 
sensor resolution, in addition to the safety distance.

• Detection of an adult's hand:

• Resolution: 30 mm
• Additional distance CRO: 128 mm

• Arm detection:

• Resolution: 40 mm
• Additional distance CRO: 208 mm

Protective field contour and reference contour
With a vertical protective field, you must define at least two sides of the protective field contour as refer-
ence contour. The objective is to monitor the position of the protective field with regard to its marginal area. 
If the arrangement misaligns and the distance of the safety sensor to the reference surface changes as a 
result, switch the safety-related switching outputs off.

SRO K T CRO+=
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1 Physical frame for reference contour
2 Reference contour, must cover at least two sides of the protective field
3 Safety sensor
4 Distance e between the reference contour frame and machine opening, recommended: e = 150 mm
5 Machine opening contour

Figure 7.13: Defining the protective field contour and reference contour, stationary point of operation 
guarding, vertical protective field

7.4 Stationary access guarding
The vertical protective field used for access guarding only detects people during passage through. After a 
person has passed through, a start/restart interlock must ensure that the dangerous movement does not 
start again automatically.
Calculation of safety distance SRT for access guarding

SRT [mm] = Safety distance
K [mm/s] = Approach speed for access guarding with approach direction orthogonal to the protec-

tive field: 2000 mm/s or 1600 mm/s, if SRT > 500 mm
T [s] = Total time of the delay, sum from (ta + ti + tm)
ta [s] = Response time of the protective device, max. 80 ms
ti [s] = Response time of the safety relay
tm [s] = Machine stopping time
CRT [mm] = Additional distance for access guarding with approach reaction with resolutions of 

14 to 40 mm, d = resolution of protective device CRT = 8  (d - 14) mm. Additional dis-
tance for access guarding for resolutions > 40 mm: CRT = 850 mm (standard value for 
arm length)

Response times, stopping time of the machine
The safety sensor's rotary mirror rotates on its own axis every 40 ms. One revolution is a scan. With each 
additional scan the response time ta increases by 40 ms. With K = 2000 mm/s approach speed this corre-
sponds with an increase in the safety distance of 80 mm per additional scan. With K = 1600 mm/s it is 
64 mm.
 Select a response time ta of 80 ms or higher. 

Never define a value higher than 80 ms for ta for access guarding or passage controls. With higher val-
ues it can happen that a person might not be detected when passing through the protective field with 
an approach speed of 1600 mm/s.

 Determine the machine/system's stopping time tm. 
If data is not available, you can commission Leuze electronic to perform measurements (see chapter 14 
"Service and support").
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 If an increase in the stopping time within the regular test periods is to be expected, take an additional 
time into account for the machine's stopping time tm. 

Additional distance CRT for finger protection

The required finger protection is ensured here by an additional distance C, which depends on the safety 
sensor resolution, in addition to the safety distance.

• Detection of an adult's hand:

• Resolution: 30 mm
• Additional distance CRT: 128 mm

• Arm detection:

• Resolution: 40 mm
• Additional distance CRT: 208 mm

Protective field contour and reference contour
With a vertical protective field, you must define at least two sides of the protective field contour as refer-
ence contour. The objective is to monitor the position of the protective field with regard to its marginal area. 
If the arrangement misaligns and the distance of the safety sensor to the reference surface changes as a 
result, switch the safety-related switching outputs off.
When defining the protective field ensure that there are no gaps bigger than 150 mm.
When defining the protective field boundaries, 

specify the sectors that monitor the position of the protective field as reference contour.

7.5 Mobile danger zone guarding on DTSs
Danger zone guarding protects people and objects that are in rooms in which vehicles move in, e.g. auto-
mated guided vehicle systems (DTSs).
A horizontally arranged protective field protects people and objects that are in the vehicle's path and are 
detected by the front edge of the protective field. 

 Only use the safety sensor on vehicles with electrical drive and electrically influenced drive and braking 
devices. 

 Only install the safety sensor on the front of the vehicle.
If you must also guard the reverse travel, you must also install a safety sensor on the rear of the vehicle. 

Mount the safety sensor on the vehicle so that there are no unmonitored areas ≥  70 mm between the 
protective field and vehicle front. 

 Set the mounting height such that the beam level is not more than 200 mm above the floor. 
A person lying on the floor can therefore be safely detected. This is required by the C standard, EN 1525 
"Safety of industrial trucks – Driverless corridor supply vehicles and their systems". 

7.5.1 Minimum distance D

D [mm] = Minimum distance, vehicle front (danger) to protective field front edge
DA [mm] = Stopping distance
ZTOT [mm] = Total required additional distances 

WARNING
Danger of injury because of insufficient vehicle stopping distance
 The operator of the machine must use organizing measures to prevent people from entering the pro-

tective field of the vehicle from the sides or being able to move towards an approaching vehicle. 

The beam level of the safety sensor is level with the alphanumerical display.

D DA ZGes+=
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Figure 7.14: Mobile danger zone guarding, calculation of required minimum distance D

Stopping distance DA

DA [mm] = Stopping distance
vmax [mm/s] = Maximum vehicle speed
T1 [s] = Safety sensor response time
T2 [s] = DTS response time
DB [mm] = Braking distance with vmax and maximum vehicle load
L1 [---] = Factor for brake wear and tear
L2 [---] = Factor for problematic floor conditions, e.g. dirt, wet conditions

Additional distances Z

ZTot [mm] = Total of the required additional distances
ZSM [mm] = Additional distance for system-related measurement error, see table 7.3
ZF [mm] = Additional distance required with lack of floor space HF

ZREFL [mm] = Additional distance required with retro-reflectors beyond the protective field boundar-
ies; ZREFL = 100 mm

The additional distance ZSM is always required. Its size depends on the biggest radius RG from the safety 
sensor mirror's rotary axis to the protective field boundary without ZTot. The position of the rotary mirror axis 
depends on the installation situation. 
The additional distance ZF is required if the vehicle does not have enough free floor space HF and there is 
therefore no space under the vehicle or the safety sensor for the tips of the feet. You determine the addi-
tional distance ZF according to the following diagram:

Figure 7.15: Diagram for determining the additional distance ZF with lack of floor space HF
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If wheels are mounted near the side wall, always add an additional distance ZF  150 mm. 

7.5.2 Protective field dimensions

D Minimum distance, vehicle front (danger) to protective field front edge 
DA Stopping distance
ZTot Total required additional distances to the front and for both sides
FL Distance from safety sensor center to left vehicle edge
FR Distance from safety sensor center to right vehicle edge 
RG Biggest radius in the protective field without ZTOT for determining the additional distance ZSM 

Figure 7.16: Mobile danger zone guarding, dimensions for horizontal protective field

 Select 70 mm resolution.
 Set the protective field length so that the response time until braking and the braking distance, including 

factors for wear and tear and floor conditions, and any necessary additional distances are taken into 
account. 

 Arrange the protective field symmetrically with reference to the vehicle width, even if the safety sensor 
is not arranged centered. 

 Configure an upstream warning field that reduces the vehicle's speed. 
A full brake with a subsequent interruption of the protective field is then executed moderately and is less 
demanding on the vehicle's drives. 
Dimension the minimum distance D for the maximum speed as if the speed reduction initiated by the 
warning field had not happened. 

 Take the required free space for lateral protrude protective fields under the roller conveyors along the 
transportation path into account. 

 If you have to expect angular deviations of the vehicle during the travel, plan an additional tolerance 
area to guarantee undisturbed travel operation. 

7.6 Mobile side guarding on DTSs

 For mobile vertical protective fields use a resolution of at least 150 mm.
 Position the protective field edges in the travel direction in accordance with the front protective field edge 

of the horizontal protective field.

ZGES

D

F R
F L

DA

Z G
E

S
Z G

E
S

RG

WARNING
Danger of injury because of insufficient vehicle stopping distance
 The operator of the machine must use organizing measures to ensure that people cannot enter the 

vehicle's protective field from the side. 
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 Ensure that the response time of all components of the switch-off circuit are the same or balance the 
response times with different protective field dimensioning.

 Set the vertical protective fields at a slight angle so that the lower protective field edges protrude over 
the vehicle width by the amount of the additional distances, ZSM, ZF and ZREFL where required; see 
figure 7.16.

7.7 Mounting accessories

7.7.1 Mounting system
Using the mounting system you can adjust the safety sensor horizontally and vertically by ±10 degrees 
when mounting.

Figure 7.17: Mounting system BTU800M

 Install the wall mount or mounting bracket for floor mounting on the system side.
Mount the mounting system on the wall mount or on the mounting bracket for floor mounting.
 Attach the safety sensor to the mounting system.

Tightening the screws fixes the safety sensor in position.
 Align the safety sensor using the integrated electronic spirit level.

NOTICE
Floor mounting only with mounting system BTU800M
 The mounting system BTU800M must be used in the case of installation using the mounting bracket 

for floor mounting. 
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7.7.2 Loop guard
The loop guard for the optics cover prevents damage to the safety sensor caused by light contact with 
foreign objects.

1 Mounting bracket for floor mounting BTF815M (only with mounting system BTU800M)
2 Mounting system BTU800M
3 Loop guard
4 Safety sensor

Figure 7.18: Loop guard

 Attach the safety sensor to the mounting system.
 Engage the loop guard for the optics cover from above into the mounting system.

The loop guard can only be used together with the mounting system BTU800M.

1

1

2

3 3

4



Electrical connection

Leuze electronic RSL 440 70

8 Electrical connection

8.1 Electrical supply
see table 15.7.

Functional earth

• Factory recommendation: Functional earth via a ground strap/braid (low impedance for RF).
Connection points for self-tapping screws used for the ground connection are provided and labeled 
on the bottom of the connection unit (see figure 8.3).

• Functional grounding via the shield of the connection cable. 
For grounding, the shield of the connection cable in the switch cabinet must be connected to earth or 
machine/vehicle ground.

8.2 Interfaces

The safety sensor has two interfaces:
• Interface for connection with the control system
• Interface for communication with PC or laptop

WARNING
Faulty electrical connection or improper function selection may result in serious injury!
 Only allow competent persons to perform the electrical connection.
 For access guarding, activate the start/restart interlock and make certain that it cannot be unlocked 

from within the danger zone. 
 Select the functions so that the safety sensor can be used as intended (see chapter 2.1 "Approved 

purpose").
 Select the safety-relevant functions for the safety sensor (see chapter 5.2 "Function modes of safety 

sensor").
 Always loop both safety-related switching outputs OSSD1 and OSSD2 into the work circuit of the 

machine.
 Signal outputs must not be used for switching safety-relevant signals.

NOTICE
Laying cables!
 Lay all connection cables and signal lines within the electrical installation space or permanently in 

cable ducts.
 Lay the cables and lines so that they are protected against external damages.
 For further information: see EN ISO 13849-2, Table D.4.

NOTICE
Always connect the housing of the safety sensor to functional earth or ground!
 The housing of the safety sensor must always be connected to earth (functional earth) or machine/

vehicle ground.
 If the safety sensor is attached to a non-conductive material (e.g. a concrete wall), the housing of the 

safety sensor must be earthed.

NOTICE
Make sure that potential equalization is provided!
 If the housing of the safety sensor or the mounting bracket – despite being mounted on a non-conduc-

tive material – is connected to metallic parts (even temporarily), you must ensure that the appropriate 
potential equalization is provided between the switch cabinet and housing potential; e.g. by grounding 
the Ethernet connection. 
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Table 8.1: Interfaces

The control cable is permanently attached to the connection unit. A protection cap on the connection unit 
protects the communication interface when no PC is connected. 

8.2.1 Connection cable, control
The safety sensor is equipped with a 29-wire connection cable.

Table 8.2: Connection cable, control

Interface Type Function

Control Connection 
cable, 29-wire

• Power supply
• Switching lines and signal lines

Communica-
tion

M12 – RJ 45 Configuration interface and data interface:
• Parameter configuration
• Protective field definition and warning field definition
• Data transmission and measurement value transmission
• Diagnosis

Wire no. Core color Color code Signal Description

3 White White RES1 Start/restart input, protective 
function A
Acknowledgement

1 (1 mm2) Brown Brown 24 V Supply voltage

4 Green Green EA1 Contactor monitoring OSSD A
Alternatively: State signaling, 
configurable

5 Yellow Yellow A1 Output signal
State signaling, configurable

6 Gray Gray OSSDA1 Safety-related switching output, 
protective function A

7 Pink Pink OSSDA2 Safety-related switching output, 
protective function A

2 (1 mm2) Blue Blue 0 V (GND) Supply voltage ground

8 Red Red MELD Output signal
State signaling, configurable

9 Black Black F1 5 function inputs for field pair 
changeover, protective function A
Field pair changeover with 100 
field pairs (A1.x) – 2nd position
Field pair changeover with multi 
configuration (A1.x) within one 
bank

10 Violet Violet F2

11 Gray/Pink Gray/Pink F3

12 Red/Blue Red/Blue F4

13 White/Green White/Green F5

14 Brown/Green Brown/Green SE1 Linkage input (E-Stop, OSSD – 
external device)

15 White/Yellow White/Yellow SE2 Linkage input (E-Stop, OSSD – 
external device)

16 Yellow/Brown Yellow/Brown A2 Output signal
State signaling, configurable
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8.2.2 Pin assignment of M12 Ethernet interface (communication) ( D-coded)
The safety sensor is equipped with a 4-pin M12 connector.

Figure 8.1: Pin assignment of the Ethernet interface

Table 8.3: Pin assignment of the Ethernet interface

17 White/Gray White/Gray A3 Output signal
State signaling, configurable

18 Gray/Brown Gray/Brown A4 Output signal
State signaling, configurable

19 White/Pink White/Pink EA2 Contactor monitoring OSSD B
Alternatively: State signaling, 
configurable

20 Pink/Brown Pink/Brown EA3 Input/output signal, configurable

21 White/Blue White/Blue EA4 Input/output signal, configurable

22 Brown/Blue Brown/Blue F6 5 function inputs for field pair 
changeover, protective function B
Field pair changeover with 100 
field pairs (Ay.1) – 1st position
Bank changeover with multi con-
figuration (Ay.1)

23 White/Red White/Red F7

24 Brown/Red Brown/Red F8

25 White/Black White/Black F9

26 Brown/Black Brown/Black F10

27 Gray/Green Gray/Green RES2 Start/restart input, protective 
function B
Acknowledgement

28 Yellow/Gray Yellow/Gray OSSDB1 Safety-related switching output, 
protective function B

29 Pink/Green Pink/Green OSSDB2 Safety-related switching output, 
protective function B

Shielding Functional earth
The shield of the connection cable is part of the metallic housing. The housing is at the 
same potential as functional earth.

Wire no. Core color Color code Signal Description

43

12

PIN Signal Description

1 TD+ Data communication, transmission

3 TD- Data communication, transmission
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8.3 Connection unit CU429

1 Connection cable, connection to the machine
2 M12 socket, D-coded, Ethernet communication connection
M5 Connection for functional earth with M5 x 10 self-cutting/self-tapping (gas tightness) and ground 

strap
Figure 8.2: Connection unit CU429

4 RD- Data communication, reception

2 RD+ Data communication, reception

FE GND/shield Functional earth, communication cable shield. The shield of the intercon-
nection cable is on the thread of the M12 plug. The thread is part of the 
metallic housing. The housing is at the same potential as functional 
earth.

PIN Signal Description

M5  2x

2 1
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8.4 Circuit diagram example

* Spark extinction circuit, suitable spark extinction provided
Figure 8.3: RSL 440 with MSI-SR4B safety relay
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9 Configuring the safety sensor
To start up the safety sensor in your application, the safety sensor must be individually adapted using the 
software. All configuration data is defined using the configuration and diagnostics software.

General procedure for configuring safety sensor
 Assessing the risk

• The system has been determined and its boundaries defined.
• The safety sensor has been selected as the safety component.
• The type of guarding has been determined (danger zone guarding, point of operation guarding, 

access guarding).
 Calculating safety distance

Shape and size of the protective and warning fields
 Configuring the safety sensor 

• Configuration and diagnostics software (see chapter 4 "Configuration and diagnostic software 
Sensor Studio")

• Determine the configuration project (see chapter 9.3 "Determining configuration project")
• Configure the protective function (see chapter 9.4 "Configuring protective function")

 Checking function (see chapter 11 "Testing")

9.1 Defining safety configuration

WARNING
Serious accidents caused by incorrect safety configuration!
The protective function of the safety sensor is only ensured if the safety sensor is correctly configured for 
the intended application.
 Allow only competent persons to perform safety configuration. 
 Select the safety configuration so that the safety sensor can be used as intended (see chapter 2.1 

"Approved purpose").
 Select the protective field dimensions and contours according to the safety distance calculated for the 

application (see chapter 7.1.1 "Calculation of safety distance S").
 Select the parameters of the safety configuration according to your risk analysis.
 After start-up, check the function of the safety sensor (see chapter 11.1 "Before the initial start-up and 

following modifications").

WARNING
Additional protection against manipulation when the monitoring time is increased!
If the monitoring time is increased to above 5 s or if manipulation protection is deactivated, the system 
operator must introduce other measures to prevent manipulation. 
 For example, make sure that the distance range in which manipulation is possible cannot be accessed 

by personnel under normal operating conditions.
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Prerequisites:

• The safety sensor is mounted (see chapter 7 "Mounting") and connected (see chapter 8 "Electrical 
connection") correctly. 

• Dangerous process is switched off, outputs of the safety sensor are disconnected, and the system is 
protected against being switched back on.

• The size of the protective field is determined on the basis of the mounting location, the calculated 
safety distances and additional distances.

• The start/restart operating mode required by the application has been determined.
• The conditions for field pair changeover, if required, have been determined. 
• The configuration and diagnostics software for the safety sensor is installed on the PC (see 

chapter 4.2 "Installing software").

Procedure
All configuration data is defined using the configuration and diagnostics software.
To configure the safety sensor, proceed as follows:
 Connect the PC to the safety sensor
 Start the software

• Set up communication
• Determine the configuration project

 Configure the protective function using the project wizard

• Protective/warning field configuration
• Resolution and response time
• Start-up behavior
• Contactor monitoring
• E-Stop linkage
• Field pair changeover
• Configuration of the signal outputs

 Save configuration project
 Transferring a configuration to the safety sensor
 Create a record document for the device configuration and protective field dimensioning. The document 

must be signed by the person responsible for the configuration. 
To document the configuration, you can create a PDF file of the safety configuration or save the config-
uration and settings in an *.xml file.

NOTICE
OSSDs will switch off if no reflection signals are being measured!
If the safety sensor is unable to measure any reflection signals in a continuous scanning angle of ≥  45° 
for a long period of time, the safety-related switching outputs switch off. In certain application types (e.g. 
in buildings with extremely large distances), the safety sensor may not be able to measure any reflection 
signals. For such application types, it is possible to set or deactivate the monitoring times.
 In the CONFIGURATION menu, click the Other option.

The OTHER dialog box opens. 
 In the PROTECTION AGAINST MANIPULATION dialog box, define the monitoring time according to 

your specific conditions.
If the parking position is active, there will be no manipulation monitoring.

Many safety-relevant parameters are preset for each application in the configuration and diag-            
nostics software. Use these preset values where possible.
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9.2 Connecting safety sensor to PC

9.2.1 Connection via Ethernet cable
Connect the Ethernet cable to the PC or to the network; see the document “Quick Start Guide RSL 400”.

9.2.2 Connection via Bluetooth

Prerequisites: Bluetooth communication of the safety sensor has been activated (see chapter 9.2.3 
"Communication between safety sensor and PC")
 Activate the Bluetooth interface on the PC.
 Select the safety sensor as the device for the Bluetooth connection.

9.2.3 Communication between safety sensor and PC
The following communication settings are active when the safety sensor is delivered:

LAN
• DHCP: Obtain IP address automatically

Bluetooth
• Bluetooth module activated
• Device scan activated

You can change the communication settings on the PC using the configuration and diagnostics software 
in order to, for example, assign a permanent IP address to the safety sensor in your network.
 Start the configuration and diagnostics software on your PC.

• The mode selection of the Project Wizard is displayed.
• If the mode selection is not shown, click the [Project Wizard] button ( ) in the menu bar of the 

software to start the project wizard.
 Select the configuration mode and click [Next].
The Project Wizard displays the device selection list containing the configurable safety sensors.
 Select the safety sensor from the device selection list and click [Next].
The initial screen for the configuration project is displayed together with information for identification of the 
selected safety sensor. 
 In the initial screen, click the SETTINGS tab.
The SETTINGS menu opens. 

The configuration data is stored in the connection unit of the safety sensor and is therefore also                
available after replacement or repair of the scanner unit. The configuration data only needs to be               
transferred again if changes are made to the configuration.

The TCP/IP protocol is used for communication via Ethernet. 

In addition to configuration, you can also use the Ethernet interface to forward measurement data              
in real-time (process data) to another computer, e.g. for vehicle navigation. This process data             
cannot be used for safety-relevant purposes.

No process data is transferred in the case of connection via Bluetooth.
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Assign permanent IP address
 Select the menu command Communication > LAN.
 In the DHCP dialog box, deactivate the Obtain IP address automatically checkbox.
 In the CONNECTION SETTINGS dialog box, enter the IP address information.

Activating/deactivating the Bluetooth interface
 Select the menu command Communication > Bluetooth.
  Activate/deactivate communication with the safety sensor via the Bluetooth interface using the Activate 

Bluetooth module checkbox. If the Bluetooth module is deactivated, communication with the safety sen-
sor via the Bluetooth interface is not possible.

 Activate/deactivate the Bluetooth device scan using the Activate device scan checkbox. If the device 
scan is deactivated, the safety sensor will not be found during the Bluetooth device scan. To allow com-
munication via the Bluetooth interface, you must enter the device identification of the safety sensor man-
ually.

9.3 Determining configuration project
 Start the configuration and diagnostics software on your PC.

• The mode selection of the Project Wizard is displayed.
• If the mode selection is not shown, click the [Project Wizard] button ( ) in the menu bar of the soft-

ware to start the project wizard.

 Select the configuration mode and click [Next].
The Project Wizard shows the list of configurable safety sensors.

 Select the safety sensor in the Sensor list and click [OK].
Alternatively, you can select the safety sensor by entering the part number or by specifying the sensor 
range and the sensor type.

The device manager (DTM) of the safety sensor shows the initial screen for the configuration project. 

During installation of the software, a user admin (without password query) is created so that you               
can start the software without user identification. If other users are registered (Tools > User man-               
agement in the FDT frame menu), you must log in at the software with a user name and pass-                  
word.

This setting allows you to connect to the safety sensor and to read out, upload, enter or change                 
the safety configuration and all settings using the RSL 400 device DTM. The password for the               
safety sensor only needs to be entered (i.e. the access level only needs to be changed) when                
the changes are downloaded to the safety sensor (see chapter 4.5.1 "Selecting access level").

You can use a prepared configuration project as a template and make changes to it. To do so,                 
select the configuration mode Open a stored project file.

If you want to load the configuration project currently stored in the safety sensor to the PC, select                 
the configuration mode Device selection with device scan and establishment of connection           
(online).
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1 Configuration Wizard
Figure 9.1: Safety configuration using Configuration Wizard

9.4 Configuring protective function
Prerequisites: The safety distance, additional distances and protective field dimensions and contours have 
been determined according to the mounting position (see chapter 7.1.1 "Calculation of safety distance S").
 In the initial screen, click the CONFIGURATION tab.

The CONFIGURATION menu opens with the options: 
• Administration
• OSSDs

If the OSSDs option in the CONFIGURATION menu is selected, the Protective function A option is 
displayed if the One protective function function mode is selected. In the Two protective functions 
function mode, the options Protective function A and Protective function B are displayed.

• Changeover order
The Changeover order option is only displayed if more than one protective/warning field pair is cre-
ated (see chapter 9.4.4 "Creating and configuring protective/warning field pairs").

• Outputs
• Other

9.4.1 Creating simple safety configuration
To create a safety configuration for simple commissioning, you must first perform five configuration steps 
to access the editor used for defining the contours of the protective and warning fields.
[]By clicking Next, you can proceed to the next configuration step without selecting the corresponding 
option in the CONFIGURATION menu.
If you make changes to the default settings in a configuration step, first click the [Confirm] button and then 
[Next].

The device manager (DTM) starts without querying the access level of the user. During commu-              
nication with the safety sensor, the safety sensor does however query the access level of the               
user. To change the access levels, see chapter 9.9 "Selecting access level". 

1
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 Administration
 OSSDs
 Protective function A
 Bank A1
 Outputs

9.4.2 Entering administration parameters
 In the CONFIGURATION menu, click the Administration option.
The ADMINISTRATION dialog box opens. 
 In the input fields, enter the device data and the project data for the configuration project.

9.4.3 Activating protective function and contactor monitoring
 In the CONFIGURATION menu, click the OSSDs option.
The OSSDs dialog box opens. 
 In the FUNCTION MODE list, select the protective function of the safety sensor. 
The Protective function A option is shown in the CONFIGURATION menu.
The Protective function B option is shown in the CONFIGURATION menu if Two protective functions was 
selected in the FUNCTION MODE list.

 In the Switch off delay time input field, select the internal safe time delay for switching off the OSSD-B 
outputs if One protective function was selected in the FUNCTION MODE list.

 In the CONTACTOR MONITORING list, activate the contactor monitoring of the safety sensor:

• EDM OSSD A
• EDM OSSD B
• E-Stop
• OSSD linkage

 Click the [Confirm] button.

9.4.4 Creating and configuring protective/warning field pairs
The changeover-capable protective/warning field pairs for the selected protective function are defined in 
configuration banks. The configuration banks are shown in the navigation tree of the configuration menu 
as “Bank”, e.g. Bank A1.

Configuring protective/warning field pairs for tow protective functions

Creating banks
 In the CONFIGURATION menu, click the Protective function A option.
The PROTECTIVE FUNCTION A dialog box opens. 
 Enter the description of the protective function in the input field. 
 In the CONFIGURATION menu, right-click the Protective function A option.

The changeover-capable protective/warning field pairs for the selected protective function are          
defined in configuration banks.

The activated contactor monitoring (EDM) is assigned to indication signal outputs IO1 and/or            
IO2. These signal outputs are thus disabled for the configuration of the signal outputs. 

Configuration of the protective and warning field pairs is described for the One protective function              
function mode (Protective function A). If you have selected Two protective functions as the func-              
tion mode, you must also configure the banks and field pairs for Protective function B following               
the described procedure.
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Select Add configuration bank.
The Add bank dialog box opens.
 In the Bank list, select the number of the bank and click the [Add] button. When you have added all 

banks for the protective function, click [Close].
The Bank [x] option is shown for each added bank under Protective function A in the CONFIGURATION 
menu.

Configuring banks
The resolution for hand, leg or body detection, the response time and start-up behavior of the safety sensor 
and the field pair changeover for the protective/warning field pairs are configured via the banks.

 In the CONFIGURATION menu, select the bank the configuration of which you want to define.
The RESOLUTION, RESPONSE TIME, START-UP BEHAVIOR and EXTENDED OUTPUT SIGNALS 
dialog boxes are displayed.
 In the RESOLUTION dialog box, enter the resolution and, if applicable, the maximum speed of a driv-

erless transportation system (DTS) in the input fields. 

 In the RESPONSE TIME dialog box, select the response time of the safety sensor. 
 In the START-UP BEHAVIOR dialog box, select the start-up behavior and the restart time of the safety 

sensor. 

 In the EXTENDED OUTPUT SIGNALS dialog box, activate the definition of output signals.
 Click the [Confirm] button.
 Configure all other banks of the protective function following the described procedure.

Create protective and warning fields
A field pair consists of one protective field and one warning field.
 In the CONFIGURATION menu, right-click the Bank 1 option under Protective function_A

Select Add field pair.
The Add field pair dialog box opens. 
 In the Field pair list, select the number of the field pair and click the [Add] button. When you have added 

all field pairs for the bank, click [Close].
The added field pairs are shown in the CONFIGURATION menu as an option under Bank 1 under Protec-
tive function_A. The Parameters option is displayed for each field pair.
 Add the field pairs for the other banks of Protective function A if one protective function with multiple 

configuration banks has been selected.
The added field pairs are shown in the CONFIGURATION menu under Bank [x] under Protective 
function A .

Configure protective and warning fields
Defining contours and boundaries for protective field and warning field

For resolution, response time and DTS speed, select the values that you used for calculating the               
safety distances and additional distances for the application assigned to the configuration bank. 

If in the Resolution and Max. DTS speed input fields you select values >0, the application usually                
used for the bank is displayed in the Application field, e.g. Point of operation guarding.

For access guarding, point of operation guarding and danger zone guarding, you must select             
Max. DTS speed = 0!

Configuration of the start-up behavior is only implemented if the corresponding electrical signal            
connections exist; see chapter 8 "Electrical connection".
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1 Toolbar of field editor
2 Display of field coordinates
3 Structure of safety configuration

Figure 9.2: Field editor with toolbar for field definition

 In the CONFIGURATION menu, click the field pair the protective and warning fields of which you want 
to define.

 Click the  button and define the contours and boundaries of the protective field.

 Click the  button and define the contours and boundaries of the warning field.
The field pair is fully configured.

 Configure all other field pairs of the configuration bank following the described procedure.

9.4.5 Configuring field pair monitoring
 In the CONFIGURATION menu, click the Parameters option of the field pair the protective and warning 

fields of which you have defined.
 Select the monitoring mode for the field pair in the Field pair monitoring list.

9.5 Defining permissible field pair changeovers
If monitoring of field pair changeover is activated, you can define the permissible sequence of field pair 
changeovers.

Determining changeover mode
 In the CONFIGURATION menu, select the protective function A option. or the Protective function B 

option.
 In the dialog box MODE FOR FIELD PAIR ACTIVATION AND CHANGEOVER, select the field pair acti-

vation, the mode for field pair changeover and, if required, the changeover time.

NOTICE
Determine protective field size!
The protective field size is determined by the calculated safety distances and additional distances that 
you determined for the application assigned to the configuration bank.

By right-clicking the field pair in the CONFIGURATION menu, you can calculate an autocontour             
for the protective or warning field.

You can determine the display options for the field editor in the menu SETTINGS > Field editor                
display options (see chapter 4.5.6 "SETTINGS"). 

2

3

1
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 Click the [Confirm] button.

Determining changeover order
 In the CONFIGURATION menu, select the Changeover order option.
The CHANGEOVER ORDER dialog box opens. 
 In the MONITORING OF FIELD PAIR CHANGEOVER dialog box, activate the Monitoring option.
 In the MONITORING OF FIELD PAIR CHANGEOVER dialog box, define the sequence of field pair 

changeovers according to your conditions.
 Click the [Confirm] button.

9.6 Configuring signal outputs
You can define which indication signals are transmitted to the individual indication signal connections.
 In the CONFIGURATION menu, select the Outputs option.
The OUTPUTS dialog box opens. 
 For each usable connection, select the function group and the function of the indication signal.
 Click the [Confirm] button.

9.7 Saving configuration
To save the changed configuration loaded in the software, you can transfer the configuration and settings 
to the safety sensor or save them in a file on the PC.

Saving safety configuration as PDF file
 In the CONFIGURATION menu, click the [Create PDF file of safety configuration] button.
 Determine the storage location and the file name for the safety configuration.
 Click [Save].
The safety configuration is saved as a PDF file.

Saving configuration and settings as file
 In the CONFIGURATION menu or in the SETTINGS menu, click the [Save configuration and settings 

to file] button.
 Determine the storage location and the name of the configuration file.
 Click [Save].
The configuration and settings are saved in the file format *.xml.

Saving configuration project as file
 In the menu bar of the FDT frame menu, click the  button.

Alternatively, select the menu command File > Save.

Field pair activation
Changeover mode

Description

Fixed selection of a 
field pair

Changeover of two field pairs

Selection by signal 
inputs
Fixed changeover 
moment

Changeover of 10 field pairs (see table 5.7)
When the changeover time has expired, the system changes over to the field 
pair which at this time has a permanent and valid assignment. Field pair 
changeover signals issued during the changeover time are ignored.
The inputs F1 - F5 are active.
The inputs F6 - F10 are active.

Selection by signal 
inputs
Overlapped monitoring

Changeover of 5 field pairs (see table 5.6)
Both field pairs are monitored during the changeover time.
The inputs F1 - F5 are active.
The inputs F6 - F10 are active.
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 Determine the storage location and the name of the configuration project file.
 Click [Save].

9.8 Transferring configuration project to safety sensor
The changes that you have made to the configuration only become effective when the changed configu-
ration project file is transferred to the safety sensor.

Prerequisites:
• The software and safety sensor are connected.
• The changed configuration project has been loaded in the software.
• The individual password for the access level Engineer is available. 

• Only users with the access level Engineer can transfer configuration data to the safety sensor. To 
change the access level, see chapter 9.9 "Selecting access level".

• If no individual password has been defined for the access level Engineer, use the preset default 
password (safety).

 In the menu bar of the FDT frame menu, click the [download arrow] button. 
Alternatively: In the FDT menu bar, select Device > Download parameters.

The software asks for the access level and the password.
 Select the access level Engineer and enter the preset default password (safety) or the defined individual 

password.
Confirm with [OK].

 Before downloading the safety configuration, check whether you are connected to the correct safety 
sensor.
Confirm the displayed safety notice with [Yes].

Figure 9.3: Check before safety configuration is downloaded

The software transfers the data of the configuration project to the safety sensor. 

Alternatively, you can transfer a configuration project saved as a file on the PC directly to the                
safety sensor.
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After successful transfer, the safety sensor immediately enters safety mode, i.e. the safety-related 
switching outputs switch on if all conditions are fulfilled.

• The configuration data is saved in the connection unit of the safety sensor.
• A copy of the safety configuration is saved in the scanner unit of the safety sensor. 

If, due to a device swap-out, the scanner unit is attached to a brand new, unconfigured connection 
unit, the safety configuration is transferred from the scanner unit to the connection unit. 

 Check the displayed signature.
 Confirm successful transfer of the safety configuration to the safety sensor with [OK].

The safety configuration has only been successfully transferred to the safety sensor when the confirma-
tion dialog is displayed during the download. 

Figure 9.4: Confirmation: safety configuration downloaded

The software has saved the configuration project in the safety sensor.

9.9 Selecting access level
Using the device manager (DTM) you can change the access level of the user, if necessary see 
chapter 5.1 "Authorization concept of safety sensor".
 Click in the DTM menu bar on the [Change access level] button ( ).
The Change access level dialog box opens.

NOTICE
Observe the safety notices regarding changes to the configuration!
Transferring the safety configuration from the scanner unit to the connection unit corresponds to recon-
figuration of the system consisting of scanner unit and connection unit.
 Observe the relevant safety notices regarding changes to the configuration (see chapter 9.1 "Defining 

safety configuration").

The safety-related switching outputs will already have switched on if all conditions are fulfilled.
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 In the Authorization list, select the item Engineer, Expert or Observer and enter the default password or 
the password defined for the individual user (see chapter 4.5.6 "SETTINGS"). 

• Default password for Engineer: safety
• Default password for Expert: comdiag

 Confirm with [OK].

9.10 Reset safety configuration
The device manager (DTM) can be used to reset the safety configuration to the default configuration (one 
protective function, no restart).
 In the DTM menu bar, click the [Reset safety configuration] button.
Users with the access level Engineer can additionally transfer the changed safety configuration to the 
safety sensor (see chapter 9.8 "Transferring configuration project to safety sensor").
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10 Starting up the device

Prerequisites:
• Safety sensor mounted (see chapter 7 "Mounting") and connected (see chapter 8 "Electrical connec-

tion") correctly
• Operating personnel were instructed in proper use
• Dangerous process is switched off, outputs of the safety sensor are disconnected, and the system is 

protected against being switched back on
 After start-up, check the function of the safety sensor (see chapter 11.1 "Before the initial start-up and 

following modifications").

10.1 Switching on

Requirements for the supply voltage (power supply unit):
• Reliable mains separation is ensured.
• Current reserve of at least 3 A is available.

 Switch on the safety sensor.

10.2 Aligning the safety sensor

To simplify alignment during start-up, the safety sensors of the RSL 400 series have an integrated elec-
tronic spirit level.
 Align the safety sensor using the integrated electronic spirit level.

10.3 Unlocking start/restart interlock

The responsible person can restore the ON state of the safety sensor following process interruptions (due 
to triggering of protective function, failure of the voltage supply).
 Unlock the start/restart interlock using the reset button.

The safety-related switching outputs are only enabled if you hold down the reset button for between 
0.12 s and 4 s.

10.4 Shutting down
Temporarily shutting down the machine with the safety sensor
When you shut down the machine with the safety sensor temporarily, you do not have to observe any more 
steps. The safety sensor saves the configuration and starts again with the switch-on with this configuration. 

WARNING
Improper use of the safety sensor may result in serious injury!
Make certain that the entire device and the integration of the optoelectronic protective device was 

inspected by competent and instructed persons.
Make certain that a dangerous process can only be started while the safety sensor is switched on

NOTICE
Faulty or incorrect alignment may result in an operating fault!
 The alignment performed during start-up should only be performed by qualified personnel. 
 Observe the data sheets and mounting instructions of the individual components.

WARNING
Premature unlocking of the start/restart interlock may result in serious injury!
If the start/restart interlock is unlocked, the system can start up automatically.
 Before unlocking the start/restart interlock, make certain that no people are in the danger zone.
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Shutting down safety sensor and removing from machine
When you shut down the safety sensor and store it away for a later use, you must reset the safety sensor 
to the factory settings. 
 Reset the safety sensor to the factory settings using the software.

In the device manager (DTM) of the safety sensor, select the CONFIGURATION tab. Click the [Reset 
safety configuration] button.

10.5 Restarting
Restarting the machine with the safety sensor
If you have only shut down the system with the safety sensor temporarily and are restarting the system 
without any changes, you can restart the safety sensor with the configuration that applied with the shut-
down. The configuration remains saved in the safety sensor. 
 Perform a function test (see chapter 11.3 "Periodically by the operator").

Starting up machine with safety sensor after modification or reconfiguration
If you have performed significant changes on the machine or have reconfigured the safety sensor, the 
safety sensor must be checked as with the initial start-up. 
 Test the safety sensor (see chapter 11.1 "Before the initial start-up and following modifications").

10.6 Starting up replacement scanner unit

The replacement scanner unit and the original scanner unit must be the same with regard to the following 
points:

• Scanner unit type in accordance with name plate or downward compatible with previous scanner unit 
with greater range and greater function range 

• Mounting on the existing connection unit

Mounting and aligning replacement scanner unit
Mount the replacement scanner unit on the connection unit instead of the original scanner unit (see 

chapter 13.1 "Changing scanner unit").

Transferring configuration to replacement scanner unit
The configuration stored in the connection unit is automatically transferred to the replacement scanner 
unit.

Transferring configuration with the PC
If the range and/or performance class of the replacement scanner unit is not compatible with the original 
scanner unit, you must adapt the configuration of the safety sensor to the replacement scanner unit.
 Connect the safety sensor's Ethernet communication interface with the PC. 

NOTICE
Realignment of safety sensor not necessary!
Realignment of the safety sensor is not necessary since the replacement scanner unit is mounted on the 
existing, aligned connection unit. 

WARNING
Malfunctioning of safety sensor due to incorrect configuration!
 The safety sensor configuration stored in the connection unit can only be adopted without changes if 

the replacement scanner unit and the original scanner unit are downward compatible with respect to 
range and performance class. 
The replacement scanner unit will reject an invalid configuration.

 Change the configuration parameters of the safety sensor using the configuration and diagnostic soft-
ware according to the performance class of the replacement scanner unit. 

 Change the configuration parameters of the safety sensor using the configuration and diagnostic soft-
ware according to the operating range of the replacement scanner unit. 
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 Configure the safety sensor according to the range and performance class of the replacement scanner 
unit (see chapter 9 "Configuring the safety sensor").

 Transfer the configuration to the safety sensor with the replacement scanner unit. 
The alphanumerical display confirms successful transfer of the configuration. 
The replacement scanner unit is not compatible with the connection unit if the safety sensor displays a 
fault.

Checking replacement scanner unit
The check performed on the replacement device depends on whether you automatically adopted the 
configuration from the connection unit or whether you transferred the changed configuration to the safety 
sensor. 
 If you adopted the configuration from the connection unit, check the safety sensor using the checklist 

for the daily test.
 If you transferred a new configuration to the safety sensor, check the safety sensor according to the rou-

tine for initial start-up (see chapter 11.1.1 "Checklist for integrator – to be performed prior to the initial 
start-up and following modifications").
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11 Testing

11.1 Before the initial start-up and following modifications

 Before they begin work, train the operators on their respective tasks. The training is the responsibility of 
the operating company.

 Attach notices regarding daily testing in the respective national language of the operator on the machine 
in a highly visible location, e.g. by printing out the corresponding chapter (see chapter 11.3 "Periodically 
by the operator").

 Test the electrical function and installation according to this document.

Acc. to IEC TS 62046 and national regulations (e.g. EU directive 2009/104/EC), tests are to be performed 
by competent persons in the following situations:

• Prior to the initial start-up
• Following modifications to the machine
• After longer machine downtime
• Following retrofitting or new configuration of the machine

 As preparation, check the most important criteria for the safety sensor according to the following check-
list (see chapter 11.1.1 "Checklist for integrator – to be performed prior to the initial start-up and follow-
ing modifications"). Completing the checklist does not replace testing by a competent person!

Not until proper function of the safety sensor is ascertained may it be integrated in the control circuit of the 
system.

11.1.1 Checklist for integrator – to be performed prior to the initial start-up and following modifications

Table 11.1: Checklist for integrator – to be performed prior to the initial start-up and following 
modifications

NOTICE
 Safety sensors must be replaced at the end of their mission time (see chapter 15 "Technical data").
 Always exchange entire safety sensors.
 For the tests, observe, if necessary, nationally applicable regulations.
 Document all tests in a comprehensible manner and include the configuration of the safety sensor 

along with the data for the safety- and minimum distances in the documentation.

WARNING
Unpredictable machine behavior during initial start-up may result in serious injury!
Make certain that there are no people in the danger zone.

NOTICE
Completing the checklist does not replace testing by a competent person!
 If you answer one of the items on the check list with no, the machine must no longer be operated (see 

table 11.1).
 IEC/TS 62046 contains additional recommendations on testing protective devices.

Check: Yes No n. a.a)

Is the safety sensor operated acc. to the specific environmental conditions that 
are to be maintained (see chapter 15 "Technical data")?

Is the safety sensor correctly aligned and are all fastening screws and connec-
tors secure?

Are safety sensor, connection cables, connectors, protection caps and command 
devices undamaged and without any sign of manipulation?
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Does the safety sensor satisfy the required safety level (PL, SIL, category)?

Are the safety-related switching outputs (OSSDs) integrated in the downstream 
machine control acc. to the required safety category?

Are switching elements that are controlled by the safety sensor monitored 
according to the required safety level (PL, SIL, category) (e.g., contactors 
through EDM)?

Are all points of operation near the safety sensor accessible only through the 
protective field of the safety sensor?

Are the necessary additional protective devices in the immediate surroundings 
(e.g., safety guard) properly mounted and secured against tampering?

If it is possible to be present undetected between the safety sensor and point of 
operation: is an assigned start/restart interlock functional?

Is the command device for unlocking the start/restart interlock mounted in such a 
way that it cannot be reached from within the danger zone and so that the com-
plete danger zone can be seen from the installation location?

Has the maximum stopping time of the machine been measured and docu-
mented?

Is the required safety distance maintained?

Does interruption with a test object intended for this purpose cause the danger-
ous movement(s) to stop? 

Is the safety sensor effective during the entire dangerous movement(s)?

Is the safety sensor effective in all relevant operating modes of the machine?

Is start-up of dangerous movements reliably prevented if the protective field is 
interrupted with a test object intended for this purpose?

Was the sensor detection capacity successfully tested (see table 11.2)?

Were distances to reflective surfaces taken into account during configuration and 
no reflection bypasses subsequently detected?

Are notices for regular testing of the safety sensor legible to the operator and are 
they located in a highly visible location?

Are changes to the safety function (e.g. protective field changeover) not easy to 
achieve through tampering?

Are settings that could result in an unsafe state possible only by means of key, 
password or tool?

Are there incentives that pose stimulus for tampering?

Were the operators instructed prior to starting work?

a) not applicable

Check: Yes No n. a.a)
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11.2 To be performed periodically by competent persons
The reliable interaction of safety sensor and machine must be periodically tested by competent persons in 
order to detect changes to the machine or impermissible tampering with the safety sensor.
Acc. to IEC/TS 62046 and national regulations (e.g., EU directive 2009/104/EC), tests of elements which 
are subject to wear must be performed by competent persons at regular intervals. Testing intervals may 
be regulated by nationally applicable regulations (recommendation acc. to IEC/TS 62046: 6 months).
 Have all tests performed by competent persons.
 Observe the nationally applicable regulations and the time periods specified therein.
 As preparation, observe the checklist (see chapter 11.1 "Before the initial start-up and following modifi-

cations").

11.3 Periodically by the operator
The function of the safety sensor must be checked periodically depending on the given risk (e.g. daily or 
on change of shifts) according to the following checklist so that damages or prohibited tampering can be 
detected.
Due to complex machines and processes, it may be necessary under certain circumstances to check some 
points at longer time intervals. Observe the classification in “Test at least” and “Test when possible”.

11.3.1 Checklist – periodically by the operator

WARNING
Unpredictable machine behavior during the test may result in serious injury!
Make certain that there are no people in the danger zone.
 Before they begin work, train the operators on their respective tasks and provide suitable test objects 

and an appropriate test instruction.

NOTICE
 If you answer one of the items on the check list with no, the machine must no longer be operated (see 

table 11.1).
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Table 11.2: Checklist – regular function test by trained operators/persons

Test at least: Yes No

Are safety sensor and connectors securely mounted and free of obvious signs of dam-
age, changes or tampering?

Were obvious changes made to access or entry possibilities?

Test the effectiveness of the safety sensor:
• The LED 1 and LED 6 on the safety sensor must illuminate green (see chapter 3.3.1 

"LED indicators").
• Interrupt the protective field using a suitable opaque test object (see figure 11.1).

Figure 11.1: Checking the protective field function with test rod

Do the LED 1 and LED 6 on the safety sensor illuminate constantly red while the protec-
tive field is interrupted?

When possible, test during running operation: Yes No

Protective device with approach function: during machine operation, the protective field 
is interrupted with the test object – are the obviously dangerous machine parts stopped 
without noticeable delay?

Protective device with presence detection: the protective field is interrupted with the test 
object – does this prevent operation of the obviously dangerous machine parts?



Diagnostics and troubleshooting

Leuze electronic RSL 440 94

12 Diagnostics and troubleshooting

12.1 What to do in case of failure?
After switching the safety sensor on, the display elements assist in checking the correct functionality and 
in faultfinding (see chapter 3.3 "Display elements").
In case of failure, you can determine the fault from the LED displays and read a message from the display. 
With the error message you can determine the cause of the error and initiate measures to rectify it.

12.2 Diagnostics displays
The diagnostics displays consist of one letter plus four numbers, divided into classes consisting of letters 
and the first number.

Diagnostics classes:
• I (Information)

• No OSSD switch-off
• Unhindered operation possible

• U (Usage)
Application error

• E (External)
External fault

• F (Failure)
Internal device error

• OSSD switch-off
• Self test unsuccessful
• Hardware error

• P (Parameter)
Inconsistency in configuration

Table 12.1: Diagnostics displays in order of ascending ID number

NOTICE
If the safety sensor responds with an error display, you will often be able to eliminate the cause yourself!
 Switch off the machine and leave it switched off.
 Analyze the cause of the fault using the diagnostics displays and rectify the fault.
 If you are unable to rectify the fault, contact the Leuze electronic branch responsible for you or call the 

Leuze electronic customer service (see chapter 14 "Service and support").

Diagnos-
tic ID

Diagnostics message Measure

U0370 Input level at the electrical inputs is unclear. Check the wiring of the safety sensor.

P0409 Safety configuration is not compatible: 
unknown bank switchover.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0410 Safety configuration is not compatible: 
unknown output signals.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.
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P0413 Safety configuration is not compatible: 
unknown inputs SE1 and SE2.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0414 Safety configuration is not compatible: 
unknown EDM inputs.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0415 Safety configuration is not compatible: 
unknown field pair monitoring mode.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0416 Safety configuration is not compatible: 
unknown field pair monitoring parameters.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0417 Safety configuration is not compatible: 
unknown field pair monitoring mode.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0419 Safety configuration is not compatible: 
unknown monitoring parameter for the 
changeover order.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0420 Safety configuration is not compatible: 
unknown monitoring mode of the field pair 
changeover.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0421 Safety configuration is not compatible: 
unknown parameter for field pair changeover 
monitoring.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0422 Safety configuration is not compatible: 
unknown field pair selection mode.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0423 Safety configuration is not compatible: 
unknown field pair selection parameter.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

Diagnos-
tic ID

Diagnostics message Measure
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P0424 Safety configuration is not compatible: 
unknown parameter for manipulation moni-
toring.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0425 Safety configuration is not compatible: 
unknown configuration of the output signals.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0426 Safety configuration is not compatible: 
unknown resolution.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0427 Safety configuration is not compatible: 
unknown parameter.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0428 Safety configuration is not compatible: 
unknown reflector mode.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0429 Safety configuration is not compatible: 
unknown start/restart mode.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0430 Safety configuration is not compatible: 
unknown start mode.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0431 Safety configuration is not compatible: 
unknown restart mode.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0432 Safety configuration is not compatible: 
unknown OSSD stop mode.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

U0573 EDM fault at system start. Check the wiring of the downstream relays 
and that they are functioning correctly.

U0574 Switching fault, EDM at OSSD A: external 
relay does not switch off.

Check the wiring of the downstream relays 
and that they are functioning correctly.

Diagnos-
tic ID

Diagnostics message Measure
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U0575 Switching fault, EDM at OSSD A: external 
relay does not switch on.

Check the wiring of the downstream relays 
and that they are functioning correctly.

U0576 Switching fault, EDM at OSSD B: external 
relay does not switch off.

Check the wiring of the downstream relays 
and that they are functioning correctly.

U0577 Switching fault, EDM at OSSD B: external 
relay does not switch on.

Check the wiring of the downstream relays 
and that they are functioning correctly.

U0580 Switching fault at inputs SE1 and SE2; exter-
nal safety device does not switch in accor-
dance with the specifications.

Check the wiring of the external safety 
device and that the parameter settings in the 
configuration are correct.

U0582 Field pair changeover is not performed in 
accordance with the specifications config-
ured in the safety sensor: overlap time too 
long.

Check the changeover times of function 
inputs F1 to F10 or the parameter settings in 
the configuration.

U0583 Field pair changeover is not performed in 
accordance with the specifications config-
ured in the safety sensor: no signal for field 
pair activation.

Check the wiring and the changeover times 
of function inputs F1 to F10.

U0584 Field pair changeover is not performed in 
accordance with the specifications config-
ured in the safety sensor: changeover time 
exceeded.

Check the changeover times of function 
inputs F1 to F10 or the parameter settings in 
the configuration.

U0585 Field pair changeover is not performed in 
accordance with the specifications config-
ured in the safety sensor: changeover order 
not observed.

Check the wiring of function inputs F1 to F10 
and that the parameter settings in the config-
uration are correct.

E0588 Optics cover is soiled. Clean the optics cover. Restart the safety 
sensor.

I0604 Optics cover is soiled. Clean the optics cover as soon as possible. 
Sensor is still in safety mode.

P0653 Safety configuration is not compatible: pro-
tective/warning field radius too large.

Swap out the safety sensor or change the 
configuration. The type of safety sensor 
must be the same as the type stored in the 
connection unit or in the Sensor Studio soft-
ware.

P0654 Field pair changeover is not performed in 
accordance with the specifications config-
ured in the safety sensor: field pair not 
defined.

Check the wiring of function inputs F1 to F10 
and that the parameter settings in the config-
uration are correct.

I0660 Field pair changeover is not performed in 
accordance with the specifications config-
ured in the safety sensor: no field pair acti-
vated at system start.

Check the wiring of function inputs F1 to F10 
and that the parameter settings in the config-
uration are correct.

U0661 Safety-related switching outputs (OSSDs) 
cannot be switched: short circuit with 0 V, 
+24 V DC or between OSSDs.

Check the wiring of the OSSDs.

Diagnos-
tic ID

Diagnostics message Measure
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I0719 Timeout of signals RES1 or RES2 (acknowl-
edgment button, start/restart).

Check the wiring of inputs RES1 and RES2. 
The time specifications for start/restart must 
be observed.

P0747 Safety configuration is not compatible: pro-
tective/warning field radius too small.

Change the dimensions and contour of the 
protection field in the configuration. The min-
imum range of the protection field must be 
observed.

I0825 Simulation mode has been activated. The safety-related switching outputs 
(OSSDs) have been switched off.

I0826 Simulation mode has been deactivated. The sensor is again in safety mode. 
CAUTION!
Be aware of potential hazards which can 
occur when the machine is started up!

F.... The monitoring functions have detected an 
internal error.

Create the service file (see chapter 4.5.5 
"DIAGNOSIS")and contact the 
Leuze electronic customer service (see 
chapter 14 "Service and support").

Diagnos-
tic ID

Diagnostics message Measure



Care, maintenance and disposal

Leuze electronic RSL 440 99

13 Care, maintenance and disposal

13.1 Changing scanner unit
If the safety sensor check or an error message indicates a defective scanner unit, change the scanner unit. 
Only a trained and competent person is permitted to change the scanner unit. 

The scanner unit is changed as follows: 
• Detach the scanner unit from the connection unit.
• Attach the replacement scanner unit to the connection unit.

 Undo the quick-release fasteners on both sides of the scanner unit.
 Pull the scanner unit off the connection unit.
 Place the new scanner unit on the connection unit.
 Connect and lock the new scanner unit using the quick-release fasteners on both sides.
 Check the configuration of the safety sensor (see chapter 9 "Configuring the safety sensor").

 Check the safety sensor according to the routine for initial start-up (see chapter 11.1.1 "Checklist for 
integrator – to be performed prior to the initial start-up and following modifications").

NOTICE
Safety sensor malfunction caused by dirt!
 Perform all work in an environment which is as dust-free and dirt-free as possible.
 Do not touch any of the parts inside the device.

WARNING
Malfunctioning of safety sensor due to incompatibility of connection unit and scanner unit! Malfunctioning             
of safety sensor due to incorrect configuration!
Wherever possible, replace the scanner unit with a scanner unit with the same range and performance 

class (e.g. RSL 420-M with RSL 420-M). The safety sensor configuration stored in the connection unit 
is only adopted without changes if the new scanner unit supports all configured functions.

 Change the configuration parameters of the safety sensor using the configuration and diagnostic soft-
ware according to the performance class of the scanner unit or of the connection unit. 
If a scanner unit is attached to a connection unit with a lower performance class (e.g. a scanner unit 
RSL 430 to a connection unit CU416), the integrated cable management of the connection unit means 
that only the functions of the lower performance class (of the connection unit) are available.
If a scanner unit is attached to a connection unit with a higher performance class (e.g. an RSL 420 
scanner unit to a CU429 connection unit), the performance of the scanner unit restricts the functions 
to those of the lower performance class (of the scanner unit). 

 Change the configuration parameters of the safety sensor using the configuration and diagnostic soft-
ware according to the operating range of the replaced scanner unit.
If the scanner unit is replaced with a scanner unit with a different range (e.g. RSL 420-L with  
RSL 420-M), you must check and, if necessary, adapt the configuration of the safety sensor.

Detailed information on attaching the scanner unit can be found in the document “Quick Start              
Guide RSL 400”.

If a preconfigured scanner unit is attached to a brand new, unconfigured connection unit, the              
safety configuration stored in the scanner unit is transferred to the connection unit and you can               
use the safety sensor without reconfiguration after a restart.
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13.2 Cleaning the optics cover
Clean the optics cover as required by the application-related load rating.
Use the cleaning set consisting of special cleaning agent and cleaning cloths for cleaning (see chapter 17 
"Ordering information and accessories"). 
The procedure for cleaning depends on the kind of contamination:

 Soak cloth with cleaning agent.
Wipe optics cover free in one swipe.

13.3 Servicing
The device does not normally require any maintenance by the operator.
Repairs to the device must only be performed by the manufacturer.
 For repairs, contact your responsible Leuze electronic subsidiary or Leuze electronic customer service 

(see chapter 14 "Service and support").

13.4 Disposing
 For disposal observe the applicable national regulations regarding electronic components.

Soiling Cleaning

Particles, loose, scouring  Vacuum without touching or blow away softly, oil-free
Wipe free in one swipe with cleaning cloth

Particles, loose, non-scouring  Vacuum without touching or blow away softly, oil-free
or
Wipe free in one swipe with cleaning cloth

Particles, sticking Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Particles, statically charged  Vacuum without touching
Wipe free in one swipe with cleaning cloth soaked with cleaning 

agent

Particles/drops, smearing Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Water drops Wipe free in one swipe with cleaning cloth

Oil drops Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Fingerprints Wet with cloth soaked in cleaning agent
Wipe free in one swipe with cleaning cloth

Scratches  Change optics cover

NOTICE
The wrong cleaning agents or cloths will damage the optics cover!
 Do not use any scouring cleaning agents or scratching cloths.

If cleaning takes longer than four seconds, e.g. with fingerprints, the safety sensor displays a              
fault of optics cover monitoring. After cleaning is complete, the safety sensor resets itself auto-              
matically. 
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14 Service and support

24-hour on-call service at:
+49 (0) 7021 573-0

Service hotline: 
+49 (0) 8141 5350-111
Monday to Thursday, from 8.00 a.m. to 5.00 p.m. (UTC+1)
Friday, 8.00 a.m. to 4.00 p.m. (UTC+1)

E-mail:
service.protect@leuze.de

Return address for repairs:
Service center
Leuze electronic GmbH + Co. KG
In der Braike 1
D-73277 Owen / Germany
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15 Technical data

15.1 General specifications

Table 15.1: Safety-relevant technical data

Table 15.2: Optics

Table 15.3: Protective field data

Type in accordance with IEC/EN 61496 Type 3

SIL in accordance with IEC 61508 SIL 2

SILCL in accordance with IEC/EN 62061 SILCL 2

Performance Level (PL) in accordance with 
EN ISO 13849-1

PL d

Category acc. to EN ISO 13849-1 Cat. 3

Average probability of a failure to danger per hour 
(PFHd)

9x10-8 1/h

Mission time (TM) 20 years

Laser protection class in accordance with  
EN 60825-1

Class 1 

Wavelength 905 nm (infrared)

Impulse duration 2.5 ns

Maximum output power (peak) 35 W

Pulse frequency of laser transmitter 90 kHz

Scanning rate 25 scans/s, equal to 40 ms/scan

Scanning angle Max. 270 °

Angular resolution 0.1 °

Tolerance field of reference contour + 200  mm

Safety sensor RSL 410 RSL 420 RSL 430 RSL 440

Number of field pairs 1 10 10 + 10 100

Reference contour selectable x x x x

Minimum adjustable range 200 mm

Detection range of the test object from the 
housing edge

The detection capability is limited in the 0 mm to 50 mm 
range to increase availability. 

Diffuse reflectance PF minimum 1.8 %
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Table 15.4: Protective field range

Table 15.5: Warning field data

Table 15.6: Measurement field data

Table 15.7: Electrical supply

Device range S M L XL

Resolution [mm] Protective field range [m]

150 3.00 4.50 6.25 8.25

70 3.00 4.50 6.25 8.25

60 3.00 4.50 6.25 8.25

50 3.00 4.50 6.25 6.25

40 3.00 4.50 4.50 4.50

30 3.00 3.50 3.50 3.50

Number of field pairs 1, 10, 10 + 10, 100

Warning field range 0 - 20 m

Object size 150 mm x 150 mm

Diffuse reflectance WF minimum Min. 10 %

Detection range 0 - 50 m

Diffuse reflectance 20 %

Radial resolution 5 mm

Lateral resolution 0.1 °

Voltage supply
Power supply unit

24 V DC (+20 % / -30 %)
Supply acc. to IEC 742 with secure mains supply 
isolation and equalization for voltage dips of up to 
20 ms acc. to EN 61496-1.

Voltage supply
Battery

24 V DC (+20 % / -30 %)
(performance data may differ) 

Overcurrent protection Via 2 A semi-time-lag fuse in the cabinet
Notice: With high external loads at the switching 
outputs (total current > 700 mA), the fuse rating 
must be adjusted to 2.5 A.

Current consumption Approx. 700 mA (use power supply unit with 3 A)

Power consumption 17 W with 24 V plus output capability

Overvoltage protection Overvoltage protection with protected limit stop 

Protective conductor Connection required

Device connection Connection cable, 29-wire

Connection socket for Ethernet/communication M12-4 connector, D-coded
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Table 15.8: Inputs

Table 15.9: Safety-related switching outputs

Table 15.10: Inputs and outputs

Reset +24 V, dynamically monitored (0.12 s to 4 s)

Field pair changeover Selection of 10, 10 x 10 or 100 field pairs via 
10 control cables
+24 V, dynamically monitored

Signal definition:

High/logical 1 16 - 30 V

Low/logical 0 < 3 V

OSSD transistor safety-related switching outputs 4 safe PNP semiconductor outputs
Short-circuit proof, cross circuit monitored

Minimum Typical Maximum

Response time 80 ms 
(2 scans)

1000 ms 
(25 scans)

Switching voltage high active UB – 3.2 V

Switching voltage low 2.0 V

Switching current 300 mA

Cut-off frequency fg 1 kHz

Load capacity Cload 100 nF

Cable length between safety sensor and load with 
cross section 0.25 mm2

25 m

Permitted wire cross section 0.25 mm2

Test pulse width 60 µs 110 µs

Test pulse distance 35 ms 40 ms 40 ms

The safety-related transistor outputs perform the spark extinction. With transistor outputs, it is            
therefore neither necessary nor permitted to use the spark extinction circuits recommended by            
contactor or valve manufacturers (RC elements, varistors or recovery diodes), since these con-            
siderably extend the decay times of inductive switching elements.

Features Max. output cur-
rent Ia

Min. input cur-
rent Ie

Typical connection 
components

E=input
(F1-F10) PNP/NPN, can be changed over 
together

--- 4 mA
(-4 mA)

Switching contacts
Control/sensor output

E=input
(RES1, RES2) PNP/NPN changeover 
together with F1-F10

--- 10 mA
(-20 mA)

Start/Restart

E=input
(SE1/SE2) changeover

--- 4 mA
(<1 mA=OFF)

E-stop input
OSSD linkage
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Table 15.11: Software

Table 15.12: General system data

EX/A=changeover-capable
(EA1, EA2)

20 mA
(-20 mA)

10 mA
(-10 mA)

Auxiliary contact of 
power contactor 
(EDM)

E/A=changeover-capable
(EA3, EA4)

20 mA
(-20 mA)

4 mA
(-4 mA)

Switching contacts
Sensor output
Control output

A=output
Current limited, short-circuit proof
(A3, A4)

20 mA
(-20 mA)

--- Control input

AX=output
Current limited, short-circuit proof
(A1, A2, MELD)

100 mA
(-20 mA)

--- Lamp (PNP only)
Control input (PNP/
NPN)

Signal definition:

High/logical 1 16 - 30 V

Low/logical 0 < 3 V

Configuration and diagnostics software Sensor Studio for Windows 7 and Windows 8.1

Degree of protection IP 65 in acc. with IEC 60529

Safety class III

Ambient temperature, operation  0 ... +50 °C

Ambient temperature, storage  -20 ... +60 °C

Humidity DIN 40040, table 10, code letter E (reasonably 
dry)

Interference rejection In acc. with DIN EN 61496-1 (type 4), also in acc. 
with DIN 40839-1/3 test pulses 1, 2, 3a, 3b and 5

Vibration stress over 3 axes In acc. with IEC 60068 part 2 - 6, 10 - 150 Hz 
max 5 G

Continuous shock over 3 axes In acc. with IEC 60068 part 2 - 29, 10 G, 16 ms

Disposal Specialist disposal required

Housing Diecast zinc, plastic

Standard version dimensions (ensure free space for 
plug with fixing and connection cable)

140 x 149 x 140 (W x H x D) in mm

Weight of standard version incl. connection unit Approx. 3 kg

Distance, beam level center to bottom housing edge 104 mm
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15.2 Dimensions

all dimensions in mm
1 Scan level

Figure 15.1: Dimensions safety laser scanner with connection unit
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all dimensions in mm
Figure 15.2: Mounting dimensions safety laser scanner with connection unit

all dimensions in mm
Figure 15.3: Minimum space requirements for installation and replacement of scanner unit

all dimensions in mm
1 Reference point for distance measurement and protective field radius

Figure 15.4: Dimensions of scanning range
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15.3 Dimensioned drawings: Accessories

all dimensions in mm
Figure 15.5: Mounting system BTU800M
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all dimensions in mm
Figure 15.6: Mounting bracket BTF815M
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all dimensions in mm
Figure 15.7: Mounting bracket BTF830M
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all dimensions in mm
Figure 15.8: Loop guard BTP800M

all dimensions in mm
Figure 15.9: Mounting bracket BT840M
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all dimensions in mm
Figure 15.10: Mounting bracket BT840M, view A

all dimensions in mm
Figure 15.11: Mounting bracket BT856M
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all dimensions in mm
Figure 15.12: Mounting bracket BT856M, view A
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all dimensions in mm
Figure 15.13: Drilling template for adapter plate, RS4/ROD4 BT800MA
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all dimensions in mm
The mounting plate BTU804MA supplements the old mounting system of the RS4/ROD4 for the 
mounting system BTU800M.

Figure 15.14: Mounting plate BTU804MA

15.4 Representation of safety sensor status
The table lists all logic and electrical signals that are present in the safety sensor. The signal names are 
used consistently throughout the configuration and diagnostics software (device DTM), in the event log 
and in the data telegram.

Table 15.13: Representation of status
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Byte Bit Signal Description Value “0” Value “T” Default

0 --- --- Type (variant) of status profile.
Extensions require new type of 
status profile

--- --- 1

1 --- OP-MODE Operating mode:
• 1: Safety mode
• 2: Simulation mode

--- --- 1

Messages and OSSDs
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2 7 ERROR Collective message:
Error with switch-off

Off Message 0

6 ALARM Collective message:
Warnings with switch-off (also 
window warning)

Off Message 0

5 SCREEN Contamination display for 
optics cover
Warning and switch-off

Off Message 0

4 EDM EDM collection error Off Message ---

3 FIELD PAIR Collective message:
Fault detected by field pair 
selection monitoring

Off Message ---

2 E-STOP Error with OSSD linkage / E-
Stop monitoring

Off Message ---

1 A-OSSD OSSD state
Protective function A

Off On 0

0 B-OSSD OSSD state
Protective function B

Off On 0

E-Stop, parking and reflectors

3 7 Status-Input-SE Status of the inputs SE1 and 
SE2
E-Stop

Off On 0

6 Mode-PARK Park request fulfilled Off Parked 0

5 RFL-SEG-1 Reflector area 1 Off Reflector 
detected

0

4 RFL-SEG-2 Reflector area 2 Off Reflector 
detected

---

3 RFL-SEG-3 Reflector area 3 Off Reflector 
detected

---

2 RFL-SEG-4 Reflector area 4 Off Reflector 
detected

---

1 reserved --- --- --- ---

0 reserved --- --- --- ---

Electrical signals at sensor connection

Byte Bit Signal Description Value “0” Value “T” Default
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4 7 F1 Control input
Input group 0

--- --- 0

6 F2 Control input
Input group 0

--- --- 0

5 F3 Control input
Input group 0

--- --- 0

4 F4 Control input
Input group 0

--- --- ---

3 F5 Control input
Input group 0

--- --- ---

2 F6 Control input
Input group 1

--- --- ---

1 F7 Control input
Input group 1

--- --- ---

0 F8 Control input
Input group 1

--- --- ---

5 7 F9 Control input
Input group 1

--- --- 0

6 F10 Control input
Input group 1

--- --- 0

5 RES1 Start input
Protective function A

--- --- 0

4 RES2 Start input
Protective function B

--- --- ---

3 EA1 EDM input
Protective function A

--- --- ---

2 EA2 EDM input
Protective function B

--- --- ---

1 EA3 --- --- --- ---

0 EA4 --- --- --- ---

6 7 SE1 Linkage input --- --- 0

6 SE2 Linkage input --- --- 0

5 PNP-NPN PNP/NPN changeover npn pnp 0

4 A1 Output --- --- ---

3 A2 Output --- --- ---

2 A3 Output --- --- ---

1 A4 Output --- --- ---

0 MELD Output --- --- ---

7 --- reserved --- --- --- ---

Byte Bit Signal Description Value “0” Value “T” Default
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8-11
uint32

31-0 SCAN Consecutive numbering of 
scans
Resetting to 0 by switching off

--- --- Value

Protective function A

12 7 A-ACTIVE Protective function A is active / 
configured

Off Active 0

6 A-WF-VIO Status of active warning field
Protective function A

Violation Free 0

5 A-PF-VIO Status of active protective field
Protective function A

Violation Free 0

4 A-RES Start/restart interlock active
Start Request A

Off Active 0

3 A-CLEAR Internal signal OSSD A Off On 0

2 reserved --- --- --- ---

1 reserved --- --- --- ---

0 reserved --- --- --- ---

Field pair selection A

13 7-4 A-BANK-SEL Selected bank A
Numbers 1 … 10

--- --- 0

3-0 A-PAIR-SEL 1 First selected field pair A 
Numbers 1 … 10

--- --- 0

14 7-4 A-PAIR-SEL 2 Second selected field pair A 
Numbers 1 … 10

--- --- 0

3-0 A-PAIR-SEL 3 Third selected field pair A 
Numbers 1 … 10

--- --- 0

Output signals A

Byte Bit Signal Description Value “0” Value “T” Default
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15 7 A-WF-VIO-SEG-1 Status of active warning field 
segment
Protective function A

Violation Free 0

6 A-WF-VIO-SEG-2 Status of active warning field 
segment
Protective function A

Violation Free 0

5 A-PF-VIO-SEG-1 Status of active protective field 
segment
Protective function A

Violation Free 0

4 A-PF-VIO-SEG-2 Status of active protective field 
segment
Protective function A

Violation Free 0

3 A-FP-SEL-1 Defined field pair selected
Protective function A

Off Selected 0

2 A-FP-SEL-2 Defined field pair selected
Protective function A

Off Selected 0

1 reserved --- --- --- ---

0 reserved --- --- --- ---

Protective function B

16 7 B-ACTIVE Protective function B is active / 
configured

Off Active 0

6 B-WF-VIO Status of active warning field
Protective function B

Violation Free 0

5 B-PF-VIO Status of active protective field
Protective function B

Violation Free 0

4 B-RES Start/restart interlock active
Start request B

Off Active 0

3 B-CLEAR Internal signal OSSD B Off On 0

2 reserved --- --- --- ---

1 reserved --- --- --- ---

0 reserved --- --- --- ---

Field pair selection B

17 7-4 B-BANK-SEL Selected bank B
Numbers 1 … 10

--- --- 0

3-0 B-PAIR-SEL 1 First selected field pair B 
Numbers 1 … 10

--- --- 0

18 7-4 B-PAIR-SEL 2 Second selected field pair B 
Numbers 1 … 10

--- --- 0

3-0 B-PAIR-SEL 3 Third selected field pair B 
Numbers 1 … 10

--- --- 0

Output signal B

Byte Bit Signal Description Value “0” Value “T” Default
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19 7 B-WF-VIO-SEG-1 Status of active warning field 
segment
Protective function B

Violation Free 0

6 B-WF-VIO-SEG-2 Status of active warning field 
segment
Protective function B

Violation Free 0

5 B-PF-VIO-SEG-1 Status of active protective field 
segment
Protective function B

Violation Free 0

4 B-PF-VIO-SEG-2 Status of active protective field 
segment
Protective function B

Violation Free 0

3 B-FP-SEL-1 Defined field pair selected
Protective function B

Off Selected 0

2 B-FP-SEL-2 Defined field pair selected
Protective function B

Off Selected 0

1 reserved --- --- --- ---

0 reserved --- --- --- ---

Byte Bit Signal Description Value “0” Value “T” Default
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16 Standards and legal regulations
The following national and international legal regulations apply for start-up, technical tests and handling of 
safety sensors:

• Machinery directive 2006/42/EC [1]
• Low voltage directive 2006/95/EC [2]
• Electromagnetic compatibility 2004/108/EC [3]
• Use of Work Equipment Directive 89/655/EEC supplemented by Directive 95/63 EC [4]
• Hazardous substances 2002/95/EC
• OSHA 1910 Subpart O [5]
• Vibration EN 60068-2-6 [19]
• Eye safety (measurement laser) EN 60825-1 [20]
• Safety regulations
• Accident-prevention regulations and safety rules [6]
• Betriebssicherheitsverordnung (Ordinance on Industrial Safety and Health) and employment protec-

tion act [7]
• Product Safety Law (ProdSG) [8]
• Standards for risk assessment, e.g.

• EN ISO 12100 [9]
• EN ISO 13849-1, -2 + Ber.1:2009 [10]
• IEC 61508-1 to -7 [11]
• EN IEC 62061 [12]
• EN IEC 60204 [18]

• EN ISO 13849-1:200 [13]
• EN ISO 13855:2010 [14]
• EN/IEC 61496-3 [15]
• EN 1525 [16]
• EN 999 [21]
• IEC/TS 62046:2008 [17]
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17 Ordering information and accessories
Scope of delivery

• 1 self-adhesive notice sign “Important notices and notices for the machine operator”
• 1 original operating instructions “Safe implementation and operation” (PDF file on data carrier)
• 1 print document “Quick Start Guide RSL 400”

Table 17.1: Part numbers

Part no. Article Description

53800233 RSL440-S/CU429-5 2 OSSD pairs; 100 field pairs; 9 EAs; short range
Connection: cable, 29-wire, length 5 m
Ethernet: M12, 4-pin

53800234 RSL440-M/CU429-5 2 OSSD pairs; 100 field pairs; 9 EAs; medium range
Connection: cable, 29-wire, length 5 m
Ethernet: M12, 4-pin

53800235 RSL440-L/CU429-5 2 OSSD pairs; 100 field pairs; 9 EAs; long range
Connection: cable, 29-wire, length 5 m
Ethernet: M12, 4-pin

53800236 RSL440-XL/CU429-5 2 OSSD pairs; 100 field pairs; 9 EAs; extra long range
Connection: cable, 29-wire, length 5 m
Ethernet: M12, 4-pin

53800237 RSL440-S/CU429-10 2 OSSD pairs; 100 field pairs; 9 EAs; short range
Connection: cable, 29-wire, length 10 m
Ethernet: M12, 4-pin

53800238 RSL440-M/CU429-10 2 OSSD pairs; 100 field pairs; 9 EAs; medium range
Connection: cable, 29-wire, length 10 m
Ethernet: M12, 4-pin

53800239 RSL440-L/CU429-10 2 OSSD pairs; 100 field pairs; 9 EAs; long range
Connection: cable, 29-wire, length 10 m
Ethernet: M12, 4-pin

53800240 RSL440-XL/CU429-10 2 OSSD pairs; 100 field pairs; 9 EAs; extra long range
Connection: cable, 29-wire, length 10 m
Ethernet: M12, 4-pin

53800241 RSL440-S/CU429-25 2 OSSD pairs; 100 field pairs; 9 EAs; short range
Connection: cable, 29-wire, length 5 m
Ethernet: M12, 4-pin

53800242 RSL440-M/CU429-25 2 OSSD pairs; 100 field pairs; 9 EAs; medium range
Connection: cable, 29-wire, length 5 m
Ethernet: M12, 4-pin

53800243 RSL440-L/CU429-25 2 OSSD pairs; 100 field pairs; 9 EAs; long range
Connection: cable, 29-wire, length 5 m
Ethernet: M12, 4-pin

53800244 RSL440-XL/CU429-25 2 OSSD pairs; 100 field pairs; 9 EAs; extra long range
Connection: cable, 29-wire, length 5 m
Ethernet: M12, 4-pin
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Table 17.2: Components

Table 17.3: Accessories

Part no. Article Description

Scanner units

53800104 RSL440-S 2 OSSD pairs; 100 field pairs; 9 EAs; short range

53800108 RSL440-M 2 OSSD pairs; 100 field pairs; 9 EAs; medium range

53800112 RSL440-L 2 OSSD pairs; 100 field pairs; 9 EAs; long range

53800116 RSL440-XL 2 OSSD pairs; 100 field pairs; 9 EAs; extra long range

Connection units

53800121 CU429-5000 Connection: cable, 29-wire, length: 5 m
Ethernet: M12, 4-pin

53800122 CU429-10000 Connection: cable, 29-wire, length: 10 m
Ethernet: M12, 4-pin

53800123 CU429-25000 Connection: cable, 29-wire, length: 25 m
Ethernet: M12, 4-pin

Part no. Article Description

Mounting technology

53800130 BTU800M Laser scanner mounting system for vertical and horizontal 
alignment

53800132 BTF815M Mounting bracket for floor mounting; scanning height 
150 mm
Mounting of safety sensor only in combination with 
BTU800M

53800133 BTF830M Mounting bracket for floor mounting; scanning height 
300 mm
Mounting of safety sensor only in combination with 
BTU800M

53800134 BT840M Mounting bracket for corner mounting on posts (cham-
fered corner)
direct mounting of the safety sensor

53800135 BT856M Mounting bracket for corner mounting on posts
direct mounting of the safety sensor

53800131 BTP800M Loop guard for optics cover
Only in combination with BTU800M

53800136 BTU804MA Mounting plate for mounting system RS4 / ROD4

53800137 BT800MA Drilling template for adapter plate, RS4/ROD4

Cleaning fluids

430400 Cleaning set 1 Cleaning fluid for plastic, 150 ml, cleaning cloths, 25x, 
soft, fuzz-free

430410 Cleaning set 2 Cleaning fluid for plastic, 1,000 ml, cleaning cloths, 100x, 
soft, fuzz-free
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18 EC Declaration of Conformity

Leuze electronic GmbH + Co. KG, Sitz Owen|Registergericht Stuttgart, HRA 230712 
Liebigstraße 4, D-82256 Fürstenfeldbruck|T +49 8141 5350-0, F +49 8141 5350-190|info@leuze.de, www.leuze.de
Persönlich haftende Gesellschafterin:
Leuze electronic Geschäftsführungs-GmbH, Sitz Owen|Registergericht Stuttgart, HRB 230550 
Geschäftsführer: Ulrich Balbach 
USt.IdNr. DE145912521|Zollnummer 2554232 
Es gelten ausschließlich unsere aktuellen Verkaufs- und Lieferbedingungen.

EG-KONFORMITÄTS-
ERKLÄRUNG
(ORIGINAL)

 EC DECLARATION OF 
CONFORMITY

(ORIGINAL)

 DECLARATION CE DE 
CONFORMITE

(ORIGINAL)
     

Der Hersteller  The Manufacturer  Le constructeur 
Leuze electronic GmbH + Co. KG 

In der Braike 1, PO Box 1111 
73277 Owen, Germany

erklärt, dass die nachfolgend 
aufgeführten Produkte den 
einschlägigen Anforderungen der 
genannten EG-Richtlinien und 
Normen entsprechen. 

 declares that the following listed 
products fulfil the relevant 
provisions of the mentioned EC 
Directives and standards. 

 déclare que les produits identifiés 
suivants sont conformes aux 
directives CE et normes 
mentionnées. 

     
Produktbeschreibung:  Description of product:  Description de produit: 

Sicherheits-Laserscanner für 
Personenschutz, 

Berührungslos wirkende 
Schutzeinrichtung, 

Sicherheitsbauteil nach 2006/42/EG 
Anhang IV 

RSL 400 
Seriennummer siehe Typschild 

 Safety Laser Scanner for 
personnel protection, 

Active opto-electronic protective 
device, 

safety component in acc. with 
2006/42/EC annex IV 

RSL 400 
Serial no. see name plates 

Scanner laser de sécurité pour la 
protection des personnes, 

Èquipement de protection électro-
sensible,  

Èlément de sécurité selon  
2006/42/CE annexe IV 

RSL 400 
N° série voir plaques 

signalétiques 
     

Angewandte EG-Richtlinie(n):  Applied EC Directive(s):  Directive(s) CE appliquées: 

2006/42/EG  2006/42/EC  2006/42/CE 
2004/108/EG  2004/108/EC  2004/108/CE 

     

Angewandte Normen:  Applied standards:  Normes appliquées: 
EN 61496-1:2012;   IEC 61496-3:2008;   EN ISO 13849-1:2008 (Kat 3, PLd);   IEC 61508:2010 Part 1-4 (SIL2)

EN 62061:2005 (SIL 2);   EN 60825-1:2007;    EN 55022:2003    
     

Benannte Stelle /  
Baumusterprüfbescheinigung: 

 Notified Body /  
Certificate of Type Examination:

 Organisme notifié /  
Attestation d'examen CE de type:

T V-SÜD PRODUCT SERVICE GmbH 
Zertifizierungsstelle 

Ridlerstraße 65 
D-80339 München 

     

Bevollmächtigter für die 
Zusammenstellung der 

technischen Unterlagen: 

 Authorized person to compile the 
technical file: 

 Personne autorisée à constituer 
le dossier technique: 

André Thieme; Leuze electronic GmbH + Co. KG  
Liebigstr. 4; 82256 Fuerstenfeldbruck; Germany

     
 

   4102.21.61 ,newO
Datum / Date / Date  Ulrich Balbach, Geschäftsführer / Director / Directeur 
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